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Welcome

Dave Clews
Recording engineer Dave is iCreate’s resident 
Logic Pro X expert. This month he shows you 
how to unlock Logic’s most powerful tools. 
Head to page 32 to check out his guide.

Stephen Ashby
Steve has spent the past month rifling through all 
your iCloud problems and has turned them into 
the ultimate iCloud Genius Bar. It’s not to be 
missed, and it starts on page 14. 

Roland Waddilove
The files we carry around on USB drives are 
often ones you don’t want falling into the wrong 
hands. Let Mac guru Roland teach you how to 
encrypt those files on page 42.  

Meet the experts

“We’ve been rounding up your most pressing 
queries and finding brilliant, time-saving fixes”

 iCreate 169

One topic guaranteed to split opinion is iCloud. Of all 

the questions you send our way (keep them coming!), 

by far and away the most popular subject is Apple’s 

cloud computing system. You either don’t trust it, find it 

works sporadically or fills up too quickly. iCloud has 

made our lives infinitely easier, but everyone has 

problems with their account. That’s what we’ve been 

looking into this month – rounding up all your most 

pressing queries and finding brilliant, time-saving 

fixes. This month’s cover feature’s highlights include 

the ultimate guide to iCloud Photo Library and 

essential privacy and security advice.

macOS Sierra brought with it a raft of new 

features, including Siri’s desktop debut. Apple’s 

personal digital assistant is much more powerful 

than you think. Be sure to check out our Siri 

Masterclass and find out everything you didn’t know 

you could ask across your devices.

Enjoy the issue!

Philip Morris Editor
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#Trending

Apple’s missed 
connection

When Tim Cook announced 
Apple’s new MacBook Pro at its 
unveiling in October 2016, he 
made reference to Apple’s ability 

to skate to where the puck is going. “Every 
generation of Mac notebooks had some major 
innovation that wound up pushing the industry 
forward,” Cook said, before unveiling the 
MacBook Pro with Touch Bar. Of course, his 
comment was referring to the Touch Bar, but 
there was another innovation that didn’t quite 
hit the mark. 

A new port
The new MacBook Pros have seen equal praise 
and criticism since their introduction. The latter 
focuses on a simple question – are they truly 
for pros? The Touch Bar has yet to fully prove 

itself (but it hasn’t been out in the wild for long) 
and the lack of end-user upgrade options is 
troubling (but this is nothing new), but then 
there’s the matter of those ports. Or rather, a 
lack of them.

Depending on the model you buy, you’ve 
got just two or four USB-C ports to play with 
on your new MacBook Pro. That’s it. No HDMI, 
no Thunderbolt, no USB-A. And if USB-C 
sounds a little alien to you, you’re not alone. It’s 
a relatively new standard in the world of USB. A 
good one, yes. But it’s new and that presents 
a problem.

A dongle for everyone!
With USB-C ports on your MacBook Pro and 
a handful of accessories that employ older 
connection types (USB-A, Micro-USB, Mini-

USB), you’re left with one option to link them 
together. Dongles.

USB-C adapters, or dongles, are starting 
to pop up everywhere. There are plenty of 
third-party manufacturers touting them (and 
their quality and reliability varies), while Apple’s 
own offerings are pretty pricey. Such was the 
wave of negative opinion surrounding the 
need to buy dongles for the new MacBook 
Pro, Apple announced a price drop for them 
in its store . It’s a move that harks back to 
the iPhone 4 and ‘Antennagate’ days with 
the free case program.

On the face of it, then, this seems like 
a misstep for Apple. It introduced a new 
connection type and left people with the
choice of upgrading their accessories or 
buying dongles. Look into the history of 

Has Cupertino cut one 
port too many for the pros?

Top USB-C accessories Got a new MacBook Pro? You’ll want these accessories
Belkin Thunderbolt 3 Express 
Dock HD  TBA
On paper, Belkin’s Thunderbolt 
3 dock (which uses the USB-C 
connection) delivers. As well as 
providing a range of connectivity 
options, including Ethernet and 
DisplayPort, it supplies 85 watts of 
power. It’s slated for sale ‘soon’.

Samsung T3 USB 3 2TB 
External SSD  £762.58/$799.99
Don’t be put off by the price. 
Samsung’s external drive uses USB 
3.0 (which uses the same connection 
as USB-C), has 
a whopping 2TB 
of storage space 
and uses solid 
state storage 
for speed.

SanDisk Ultra Dual Drive USB 
Type-C  £35.99/$67.49 (128GB)
It’s a rarity, but if you’re still in a 
position where you need to move 
files around the old fashioned way
SanDisk’s lat
will ensure yo
can connect
via USB-A an
USB-C 
ports.

HyperDrive USB-C Hub  
£59.95/$59.95
HYPER has been getting attention with 
its latest USB-C on Kickstarter, but 
this older model uses just one USB-C 
port and gives you two USB 3.0 Type-A 
ports, plus HDMI connectivity.
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If you want your existing
peripherals to work with
the new MacBook Pro,

you’ll need some dongles

Apple has
continued its flash
sale of dongles
well into 2017

Apple, though, and it becomes obvious that 
there’s a different way this could all play out. 

A history of cuts
Tim Cook wasn’t reciting a marketing line when
he talked about pushing the industry forward. 
History tells us that it’s true. Apple dropped the
Floppy Disk storage standard with the iMac,
and it did a similar thing more recently with the
optical disc drive. It’s also seen the back of the
FireWire port, the VGA port and many other
ports before that. The transition was painful
– now, though, a lot of these technologies
feel like ancient history. The cloud is slowly
replacing the need for portable storage, and
when was the last time anyone asked you for a
FireWire 400 cable?

An early warning
Apple’s USB-C ‘warning shot’ came with the
2015 Retina MacBook. While it was wildly

Griffin 60-Watt BreakSafe
USB-C Power Cable
£29.99/$39.99
Griffin’s USB-C BreakSafe cables pick
up where Apple’s MagSafe charger left
off, breaking away cleanly from your
Mac and avoiding it falling off the table.
A new, 100-watt version (pictured) will
be out later in 2017.

heralded as a beautiful step forward in the 
MacBook line, it featured just a single USB-C 
port. In a lot of ways, this move made sense. 
Apple produced a Mac that balanced portability 
and power perfectly, possibly more than any 
of its predecessors. But it still presented 
issues – how do you charge both your Mac 
and connect, well, anything at the same time? 
Dongles, obviously.

The MacBook got away with its single port, 
though. And that’s largely down to its audience: 
it’s not a machine that’s designed with pro or 
power users in mind. Hooking up a peripheral 
is a less-common occurrence for the casual 
user, especially for one that fully embraces 
iCloud. Transferring photos from your iPhone to 
your Mac feels like an antiquated process in the 
age of iCloud Photo Library.

A promising future
While it’s true that MacBook Pros are ostensibly 
for pro users, and that you have to resort to a 
dongle every time you want to use a peripheral 
that’s not natively connected via USB-C, 
there’s still hope here. If history is anything 
to go by, weathering this rough weather of 
connectivity might leave us all with a better 
connected future. USB-C is fast, it’s a reversible 
connection and its size means that Macs can 
be made smaller.

To make it a success, though, Apple needs 
to adopt USB-C across the board. That means 
phasing it into the bottom of every new iPhone 
and iPad. It might be a while off, or it might 
never happen, but if anything is clear, it’s that 
USB-C is here to stay. The real question is how 
long it’ll be before we all choose to adopt it.
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#Trending

The iPhone marks 
its 10th anniversary

Things we learned 
this month

The device that revolutionised 
the smartphone industry as we 
know it is officially ten years old. 
Apple’s iPhone was originally 

touted as being ahead of its time, and it’s 
since become one of the most iconic pieces 
of technology ever created. Since its inception 
back in 2007, the iPhone and its numerous 
follow-ups have been purchased over a billion 
times, helping propel Apple towards the top of 
the tech industry.

While Apple’s 11 generations of iPhone have 
all been successes in one form or another, 
increased pressure from competitors have seen 
last year’s iPhone sales drop for the first time 
in history. Alongside the creation of the iPhone, 

the App Store will also soon be celebrating 
its ninth birthday. In that time, millions of apps 
have come and gone and millions more are 
being downloaded every day. We can’t wait to 
see what the next ten years have in store.



developers
$20 billion in
p Store App Store
pp Store is renowned for breaking
s and due to the fact it’s now
le in 155 countries, even more
s are being smashed. Official 
wn that iOS App Store developers
20 billion in 2016. “2016 was a
year for the App Store. We want to
veloper community for the many
ey have created,” said Apple’s 
wide marketing, Philip Schiller.

Apple bans app finding
lost AirPods Finder for AirPods

An app to help locate a lost AirPod may 
seem incredibly helpful, but not to Apple. 
The App ‘Finder for AirPods’ used the 
iPhone to track the wireless signal 

emitted from the AirPods, and had quickly garnered 
thousands of downloads. However, the excitement 
was short lived, as Apple deemed the app ‘not 
appropriate’ and subsequently pulled it from the 
App Store. While developer Raajit Sharma has 
said the app will not return to the App Store, we 
expect to see further spin-offs appear in the not-so-
distant future.

Airmail gains Workflow
integration Airmail

The popular Airmail email client is 
not only getting a major update, 
but it’s also gaining full support 
for the Workflow app. The third-

party automation tool is notorious for 
simplifying many key functions of hundreds of 
iOS apps, and this direct integration is an 
exciting prospect. For Airmail users, the 
Workflow support will provide them with the 
chance to build custom Workflow creations 
that incorporate and automate email actions,
while also providing tools to systematically manage their inboxes. Grab Airmail from the iOS 
App Store for £3.99/$4.99.

iPhone 8 to sport
steel frame? iPhone

 While everyone has been expecting 
Apple to switch up the build of its latest 
iPhone, until now it’s been unknown 
what materials will be used. However, 

sources close to Apple have revealed that the 
iPhone 8 will sport an all-glass front and back, 
surrounded by a reinforced steel frame. The benefit 
of using a steel frame is of particular interest, as it’s 
believed that using it in the build will cut costs 
created by the current aluminium build by almost 
40 per cent, which over millions of devices soon 
adds up.
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We’re expecting a special 10th anniversary
model of the iPhone in September this year
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You know how much we love quick tips for making your life that bit easier
here at iCreate, and this month is no different. Whether you’re being
bothered by unknown callers on your iPhone, running out of storage
space on your iPad after a flurry of winter photos, or wanting to use a
cool new feature of macOS Sierra’s Messages app, we’ve got the tricks 
you need to get more from your iPhone, iPad and Mac. Dive in with these 
handy tips and make your life that bit easier in 2017.

MINUTE PROJECTS
TO TRY TODAY

3

1 2

#Trending

It’s always a pain
getting calls from
numbers you don’t 

recognise – or even worse, 
numbers with No Caller ID. 
With this handy tip, you will 
only hear your phone ring 
when someone in your 
contacts tries to get in touch 
with you.

1 Block all 
unknown callers

1 Find the options
Open the Settings app and navigate to
the Do Not Disturb section. This can be
used to turn off notification for all calls 
and texts if you want.

2 Go manual
Switch on the Manual option at the top.
This way, Do Not Disturb will stay on 
at all times – you’ll see the half moon 
symbol appear in the top bar.

3 Allow calls
Choose the Allow Calls From option and 
you can choose one of your groups. 
Choose All Contacts. Now, your phone 
will only ring when your contacts call.

If you have a 16GB 
device – or just love 
taking photos or 

downloading apps – you’ve 
probably had the Storage 
Almost Full warning pop up 
a number of times. With 
these useful tips you can 
quickly make some space 
on your iPad.

2 Free up 
space quickly

1 Check your storage
First, open Settings and choose 
General, then Storage & iCloud Usage.
Tap Storage and you’ll get an overview
of the apps using the most space.

2 Optimise photo storage
If you use iCloud Photo Library, open 
Settings>Photos & Camera and check 
the Optimize iPad Storage option to 
save space on your iPad.

3 Auto-delete messages
If you share a lot of media in iMessages, 
the app can quickly eat up space. Open 
Settings>Messages and change Keep 
Messages to 30 days or 1 year.

In macOS Sierra
you have the
option to send 

Read Receipts to individual 
people in individual 
conversations, rather than 
having to send them to 
everyone you ever speak to. 
Here’s how to make your 
messages more personal.

3 Send individual 
Read Receipts

1 Open a chat
If there’s someone that you’re happy 
to inform when you’ve read their 
messages, select their name from the 
list on the left of the app.

2 Reveal Details panel
Click the Details button in the top 
right of the Messages window to see 
information about the chat, including 
media sent and a Do Not Disturb option.

3 Send receipts
Check Send Read Receipts and your 
friend will see when you have read their 
messages. They need to do the same for 
you to see when they’ve read messages.



Mac OS X LinuxWindows

Incredible Creative Tools

Whether you need to pull a key, track objects, retouch images, animate titles, 

or create amazing 3D particle effects, Fusion has the creative tools you need! 

You get a true 3D workspace, the ability to import 3D models and scenes 

from software like Maya and 3ds Max, along with hundreds of tools for 

compositing, paint, animation and more!

Scaleable Studio Power

Fusion’s GPU acceleration gives instant feedback while you work, so you 

spend more time being creative and less time waiting! Fusion 8 Studio also 

includes optical flow and stereoscopic 3D tools, along with unlimited free 

network rendering and tools to manage multi user workflows, track assets, 

assign tasks, review and approve shots, and more!

For over 25 years Fusion has been used to create visual effects on 

thousands of blockbuster films, TV shows and commercials. Fusion features 

an easy to use and powerful node based interface, a massive tool set, true 

3D workspace and GPU accelerated performance all in a single application! 

Now with support for Linux, Fusion 8.2 is easier than ever to integrate into 

your existing VFX pipeline!

Hollywood’s Secret Weapon

Fusion has been used to create groundbreaking visual effects and motion 

graphics for Hollywood films such as The Martian, Thor and The Hunger 

Games, as well as on hit television shows like Orphan Black, Breaking Bad, 

Grimm and Battlestar Galactica! If you’ve ever gone to the movies or watched 

television, then you’ve seen Fusion in action!  

Work Faster with Nodes

Fusion uses nodes to represent effects and filters that can be connected 

together to easily build up larger and more sophisticated visual effects! 

Nodes are organized like a flow chart so you can easily visualize complex 

scenes. Clicking on a node lets you quickly make adjustments, without 

having to hunt through layers on a timeline!

For Mac OS X, Windows and Linux 

For Mac OS X, Windows and Linux

FUSION Free Download

FUSION  STUDIO £785*

FUSION 8
The world’s most advanced visual eff ects and motion graphics 

software is now available on Linux as well as Mac and Windows!

www.blackmagicdesign.com/uk
*SRP is Exclusive of VAT



Cloud is Apple’s vision of a shared ecosystem, 
and for the most part it’s great. You can use it 

ensure all of your files are shared between 
veral devices (and up to date on every one of 

nd lost devices with ease, sync contacts, 
nd messages between Macs, iPhones 

d much more.
similar services, it unfortunately 

exactly as it should. Cloud 
temperamental, and when 

properly, it can be a 
e not backing up its 

d requests or when 
Cloud errors can quickly 

d, worst of all, if you don’t 
quickly, it might even mean 

nt data, photos or documents 
fail or just don’t happen.

hat in mind we’ve got a very special, 
ar-style section in this month’s iCreate, 

ted entirely to solving problems with iCloud. 
re covering everything from account issues to 

security and Photos backups, so no matter what 
kind of problem you’re having, you’re likely to find 
the solution in here. In some cases, the answer 
can be quite simple and in a few seconds you’ll be 
set up once again, while others might take a little 
longer to remedy. Either way, we’ve got a whole 
host of iCloud-related problems (and solutions) for 
you to take a look at here. Let’s get started.

SOLVED
PROBLEMS

iCLOUD

FIX YOUR iCLOUD SYNCING, 
SHARING AND STORAGE WOES
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The one-stop
column for
Genius advice
I forgot my password! 
What should I do?
Don’t panic! You’ll need 
to go to iforgot.apple.
com. If you’ve set up 
two-factor authentication 
you can put in your 
number to get access, 
or alternatively you can 
answer the security 
questions you set up to 
unlock your account.

I set up a new account 
but none of my App 
Store purchases are 
listed anymore. 
What’s happened?
Your iCloud account 
uses the same login 
details as your other 
Apple account (your 
Apple ID). If you already 
have one set up with 
iTunes or the App Store, 
you don’t need to set up 
a separate account – just 
log in with those details!

It keeps saying 
Authentication Failed 
when I try to log in to 
my account.
You’re putting in the 
incorrect password! 
Open up the Apple 
ID account page in a 
browser (appleid.apple.
com) and try to log in. If 
your password is wrong it 
will tell you this, and you 
will need to go to iforgot.
apple.com to gain access 
to your account.

Apple 
Expert

1 Reset your Keychain
First, search Keychain Access with 
Spotlight, then open File>Preferences
and choose Reset My Default 
Keychain. Enter your login password 
(not iCloud password) when prompted.

2 Re-enter your password
Now, open System Preferences and 
go to iCloud Preferences. Enter your 
iCloud password when prompted, then
click the ‘Verify your password’ button
and enter the password again.

3 Connect it up
To ensure your Keychain syncs from 
iCloud, uncheck the box, then check it 
again. Enter your iCloud password to 
verify your details, and click Request 
Approval to securely add it again.

How do I manage my iCloud account details on my Mac?
I’m confused by it all. Tina Arwen

 iCloud website
The iCloud website can 
be logged into from 
anywhere, and from here 
you can manage basic 
details of your iCloud 
account. If you want 
more detailed account 
information, you can go to 
the Apple ID website.

 Preferences
On your Mac, you 
can open up System 
Preferences and choose 
the iCloud option to see 
details of your account. 
This menu has all the 
same features as the 
Apple ID website, making 
it incredibly convenient.

 Devices
In the Devices section you can view all of 
the devices that are associated with your 
Apple ID. On the iCloud website, you have 
the added benefit of being able to see where 
they are on a map, but more on that later.

 Storage space
On both the website and in System 
Preferences you can see how much iCloud 
storage space you currently have available, 
so you can plan whether or not to upgrade to 
another storage tier.

This simple solution should solve 
the problem on all your devices

My emails and calendars all 
show the wrong time zones. 

What is going on?!  Lucas Hiorns
This is a simple case of the time zone on your account 
being incorrect. Log in to your account at iCloud.com and 
open up the Settings section. In the top right you’ll see a 
Time Zone/Region section – click here and you’ll be able 
to choose which time zone you are currently in, and the 
nearest city. When you’ve set it, you’ll see that the times 
should update across all of your devices. You can choose 
the format of things like times, dates and money too.

Setting up two-factor authentication on your iCloud account is a brilliant 
idea, and will make your account much more secure.

When I try to input my iCloud details into my Mac, I get an 
‘Error setting up iCloud’ message. What should I do? Maya Grisham



iCloud photo storage explained
Clearing up confusion about iCloud photo backups

16

iCloud problems solved

1 Open Photos preferences
On your Mac, open Photos, then click 
Photos>Preferences and choose 
the iCloud tab. You can get the 
same options on an iOS device in 
Settings>iCloud>Photos. 

2 Optimise device storage
You’ll have two options here – choose 
Optimize Device Storage and the 
full-sized versions of your photos will 
be stored in iCloud, while only small 
thumbnails remain on your device.

3 Check your storage
Wait a little while for the changes to 
be implemented, then tap General in 
Settings and choose Storage & iCloud 
Usage. This will show the available space 
on your iPad.

I want my 
photos to be 

backed up to 
iCloud, but I don’t 
want them taking 
up loads of space. 
However, if I 
delete them on my 
device, they’ll also 
be deleted from 
my iCloud Photo 
Library? Lisa White

 Settings the same
The main thing to remember 
is that you should keep your 
settings for Photos the same 
on all your devices. If you have 
iCloud Photo Library enabled on 
one, you should have it enabled 
on the others.

 Limited uploads
My Photo Stream only uploads 
1,000 photos, or photos from 
the last 30 days – whichever 
is larger. Anything beyond that 
will only be stored on your 
device unless iCloud Photo 
Library is enabled.

 No video
My Photo Stream does not 
upload videos to iCloud, only 
photos. iCloud Photo Library 
backs up every photo and 
video you’ve ever taken at their 
original size, as long as you 
have the storage space.

 Choose your option
If you use iCloud Photo 
Library your content will all 
be backed up anyway, so you 
might as well leave My Photo 
Stream enabled. There’s no 
disadvantage to having it 
switched on at all times.

 Upgrade 
If you want to use iCloud Photo 
Library, it’s a good idea to take 
a look at the current size of 
your Photos library and check 
whether or not you have enough 
iCloud storage. If you don’t, 
consider upgrading.

 No storage use
The advantage of My Photo 
Stream is that the photos 
stored in it don’t count 
towards your iCloud storage 
limits. Any images and videos 
in iCloud Photo Library do use 
this storage.
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The one-stop
column for
Genius advice
My friend shared photos 
with me through iCloud, 
but he changed his 
account details and now 
they’re gone. Can I get 
them back?
They won’t be available 
to you again unless your 
friend shares them a 
second time. If you want 
to keep them permanently 
after that, select the 
album, then choose Share 
and select Save Images to 
add them to your library.

I deleted a photo by 
accident! What do I do!? 
Is it gone forever?
Don’t panic – open up 
the Albums tab and find 
Recently Deleted. Here, 
all your deleted photos 
are kept for 30 days, so 
if you accidentally scrap 
something you can get it 
back almost instantly.

I’ve edited a photo on 
my iPhone, but I want to 
see the original on my 
Mac. Where has it gone?
Editing in Photos is 
non-destructive, so 
you can simply restore 
the image back to its 
original state on your 
Mac. Open it, choose 
the Edit menu, then click 
Restore to put it back to 
the original image.

Apple 
Expert

If you set up an iCloud family, you will automatically have a shared photo 

I’m having problems with iCloud Photo Sharing, and I’m not sure 
what’s going on. Can you help? Viktor Petrov

1 Check it’s on
First, you need to make sure iCloud 
Photo Library is enabled on your 
Mac – if it isn’t, switching it on 
will fix your issue. The option is in 
Photos>Preferences.

2 Restart your Mac
If that doesn’t solve your problem, 
try the age-old technique – turn your 
Mac off, unplug it for a couple of 
seconds, then plug it back in and 
switch it back on again.

3 Sign out and in
If your problem still isn’t solved, open 
System Preferences, choose iCloud, 
sign out, then sign back in again with 
the same account. This should jump-
start the sync.

Photos taken on my iPhone appear on my iPad within a few 
seconds, but they just won’t appear on my Mac. Lee Park

 Video backup
Videos can’t be backed up to 
iPhones or iPads, but they can 
be saved to Macs and PCs. Find 
them in the shared album within 
Photos, then right-click them 
and choose Import.

 Display name
Your display name will be the 
same as the name you’ve 
added to your iCloud account. 
To change it, open System 
Preferences>iCloud and edit it 
in Account Settings.

 Missing comments
If you aren’t seeing all the 
comments on a photo, try 
closing the app, turning off the 
iCloud Photo Sharing option in 
System Preferences>iCloud, 
waiting around a minute, then 
switching it on again.

 Back up 
shared photos
When you are invited to a 
shared album, the photos in it 
aren’t automatically added to 
your own Photos library. To back 
them up, select them all and 
choose Share>Save Photos.
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iCloud problems solved

The one-stop
column for
Genius advice
Someone in my iCloud 
family bought an in-app 
purchase with their 
Apple ID, but when 
I choose Restore 
Purchases it doesn’t 
appear. Why not?
In-app purchases 
unfortunately don’t 
transfer between 
accounts, even if you’re 
in the same iCloud 
family. This is to stop one 
person buying currency 
in a game, for example, 
and then multiple people 
being able to spend it.

Can I add my friends 
to my iCloud Family 
Sharing list? What are 
the limitations?
Technically you could, 
but they would all have 
to share the same credit 
card for purchases, and 
you wouldn’t have the 
option to approve their 
purchases, as they are 
adults. Unless you’re 
really close to your 
friends, it’s best to keep 
separate accounts.

My son has lost his 
phone! What can I do!?
When Family Sharing 
is set up, you will have 
the option to share each 
person’s location with the 
group. If this was enabled, 
you can download the 
Find My iPhone app and 
use it to see the location 
of everyone’s devices on 
a map – then play a sound 
from the lost device!

Apple 
Expert

How can I set up a family photo album that will be shared 
between me and my family members in iCloud? May Blonde

Can you share 
an Apple 

Music account with 
family members? 
Matt Dowey
First, you need to set up 
your family in iCloud. Open 
Settings>iCloud on your iPhone 
and tap the Family Sharing option 
below your account name. A 
screen will appear – tap Get 
Started and invite your family 
members with their Apple IDs. 
Once they’re added, you can get 
a special Family subscription to Apple Music for £14.99/$14.99 
per month, which allows up to five other family members to use 
the full Apple Music service using their own Apple IDs.

I’m worried about 
adding my children in 

that isn’t appropriate. Can I 
monitor everything? 
Rebecca Hudson
You can, as long as the member in question is 
under 18. When someone under 18 is added to 
your family, an option in iCloud’s Family settings 
page will allow you to enable an option called 
Ask to Buy. This will ensure that every time they 
try to buy or download something from the App 
Store or iTunes, you will get a notification on your 
device, and can approve or deny the download. If 
the family member is over 18 this option won’t be 
listed, and they’ll appear as an Adult.

Get a family 
subscription to 
save money! 

 Family photos
In the Photos section of iCloud 
settings, click the Options 
button and ensure iCloud Photo 
Sharing is enabled. This will 
allow sharing with your friends 
and family.

 Start a family
Set up your family in System 
Preferences by adding 
members using their Apple IDs. 
You can edit your family settings 
here too.

 Upload and 
comment
You can upload photos to the 
Family album from anywhere 
within Photos by clicking 
the Share button, and add 
comments and Likes to other 
people’s uploads too.

 Family album
In the Shared section of your 
Photos sidebar, a Family album 
will be added automatically. 
Click it to see the photos you 
and your family have shared.
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Remember, if any of your family buys an album or a movie, you can 
download it to your devices from the Purchases tab for free!

My daughter wants apps on her iPad but she’s only 12 
– can she have an Apple account and be part of our 

iCloud family? Elaine Blunt

I have a Family
calendar set up in 

iCloud that syncs with 
my family’s devices. 
However, my iPad isn’t 
showing the calendar. 
Joanne Marsh
If iCloud isn’t syncing properly, there’s a 
quick solution that will normally solve your 
woes. First, go into the Settings or System 
Preferences app on your device and open 
the iCloud section. Choose Sign Out, and 
delete all of the information off your device 
(it will still be saved in iCloud), entering your 
password when prompted. Reboot your 
device and then go back into your iCloud 
settings and sign in. Wait for your content 
to sync and you should be up and running.

Why do my credit
card details appear 

in the Family section of 
the iCloud settings? It’s 
a little worrying! 
Justine Keys
When you set up Family Sharing through 
iCloud, you can only use one credit card, 
which is spread between all accounts. This 
way app, movie and music purchases can 
be easily shared between users without any 
confusion about who has paid for what. You 
will need to specify which card you want to 
use, and can change it at any time. Make 
sure your family knows who will be paying 
for downloads, and remember that for 
anyone under 18 you can enable an option 
to get a notification to approve (or deny) 
any purchases by that family member.

How can I hide purchases made through iTunes or the 
App Store from my iCloud family members, such as 

apps that aren’t suitable for kids? Carrie Smith

1 Find your purchases
First, open the App Store on 
your iOS device and select the 
Purchased tab from the bottom 
bar. On iPhone, this section is 
found within the Updates tab.

2 Swipe to hide
Find an app that you no longer 
want to see and swipe it left to 
reveal a HIDE option. Tap this 
option to remove the purchase 
from your list.

3 Movies and more
If you want to hide things like 
songs and movies bought in the 
iTunes Store, you’ll need to move 
to Mac and do so in the Account 
section of iTunes.

There’s an easy fix when 
iCloud isn’t syncing properly

There will be one credit card 
associated with everyone’s account

 Enter the birthday
Make sure you enter your 
child’s birthday accurately, 
as this will stop them from 
downloading content that isn’t 
in their age bracket.

 Verify you card
You’ll need to verify the card 
details associated with the 
iCloud family in order to set 
up the account for the child in 
your family.

 Enable Ask To Buy
Make sure that Ask to Buy is 
enabled – this means that every 
time your child tries to download 
an app or pay for an in-app 
purchase, you will be notified.

 Younger users
As a parent, you can create a 
special Apple ID for children 
under 13, so that they can be 
included in the iCloud family if 
they own an iOS device.
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iCloud problems solved

The one-stop
column for
Genius advice
I set up my iPad as a 
new device, but now I 
want to restore it from 
another device backup. 
Can I do that?
You can, but you’ll lose 
all of your settings and 
content. Make sure 
you transfer anything 
important to a computer, 
then choose the Reset 
All Content and Settings 
option in the Settings 
app, before setting up 
the device again from 
the backup.

I want my iPad to 
back up to iCloud 
automatically but it 
never seems to do it. 
What’s going on?
In order for iOS devices 
to back up automatically, 
they need to be switched 
on, plugged into a power 
supply, connected to 
Wi-Fi and locked. Leave it 
on and charging at night 
to ensure it backs up.

I’m about to do a 
software update on my 
iOS devices – how do I 
know if it’s backed up to 
iCloud recently?
You should always 
do a backup before a 
software update just in 
case it causes a problem 
with your device. Open 
Settings and choose 
iCloud, then scroll down 
and select Backup. You’ll 
see the last backup, and 
can tap Back Up Now to 
perform another one.

Apple 
Expert

1 Manage your storage
Open the Settings app on your 
iPhone and choose General>Storage 
& iCloud Usage. Here you can see 
how much space is still available 
in iCloud.

2 See your backups
Tap Manage Storage in the iCloud 
section and you’ll see an overview of 
your storage, including your device 
backups. Simply tap the one you 
want to delete.

3 Delete one
You can now see when the last 
backup was, and how big it was. Tap 
Delete to remove it from iCloud storage 
completely. Remember, though – once 
it’s gone, it’s gone!

I’ve got an old backup from an iPad I don’t even own anymore 
taking up space in iCloud. How can I get rid of it? Nick Bennett

space. What can I do to cut down on my storage? Tony Moss

 Manage photos
You can see how much space 
your photos and videos are 
taking up in this section. Head 
into the Photos app and have a 
purge of anything – especially 
videos – you no longer need.

 Remove app data
Apps like iMovie and some 
games will take up iCloud 
storage space too. You can tap 
on any app to see how much 
data it is using, and then delete 
any data that you no longer 
want to be stored.

 Get an upgrade
The final option is to upgrade 
your iCloud storage to the next 
tier in order to give yourself 
some breathing room and stop 
those annoying messages from 
appearing. See the opposite 
page for more details.

 View backups
Your device backups will all 
be listed here too. If you want to 
delete a backup of a device 
you don’t need, or a backup 
that’s taking up a lot of space, 
just tap it here and choose 
Delete Backup.
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using Amazon or Google’s online storage options.

When I do an 
iCloud backup 

of my device, it takes 
up so much space! 
How can I cut down 
on the back-up size? 
Ashley Green

1 Move 
your stuff

you can free 
up space by 
storing any files 
elsewhere (such 
as Dropbox) 
or saving your 
photos to a 
back-up hard 

deleting them 
from iCloud.

2 Buy more 
storage

more costly 
solution is 
to upgrade 
your iCloud 
storage to the 
next tier. Open 
iCloud settings 
and choose 

tap Change 
Storage Plan.

3 Pay 
monthly
There are 
several tiers 

each one will 
charge you 
monthly for the 
storage. You 
can downgrade 
again at 
any time if 
you change 
your mind.

How can I 
stop an 

annoying pop-up 
appearing that 
tells me I am 
out of iCloud 
storage? Is it easy 
to upgrade my 
iCloud package? 
Jin Shun

 Choose your apps
Here you can choose the apps 
that can use iCloud backups. 
The backups will include app 

data and others may use a lot.

 Check the size 
You can see the size of your 
most recent backup at the top 

the time and date of the last 
backup that was carried out.

 Next time
After you’ve tweaked the 

the Next Backup Size is smaller 
– after a few moments the next 
backup size will be calculated 
and appear here.

 Delete the backup
If you want to delete your old 

backups should delete from 
iCloud automatically after a 
little while.

 See your space
Down at the bottom of the 
screen you’ll see a bar showing 
you how much of your iCloud 

and how much free space you 
have remaining.

 Show All Apps
The apps that use the highest 
storage amount will be listed at 

how much space the rest of 

Show All Apps here.
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I hear two-factor authentication is a lot more secure 
than a simple password. How do I set it up? Jonny Wilkins 

1 Open Apple ID options
It’s really easy to set up, and 
makes your account a lot more 
secure. Get started by heading to
appleid.apple.com and logging in
with your iCloud details.

2 Turn it on
In the Security section you’ll see 
the relevant option. Click Get 
Started and answer your security
questions to confirm that you are
really you.

3 Confirm details
Once you confirm your identity, 
you’ll be guided through setup, 
and you can set up the devices 
you trust as being safe. Remember 
to save your Recovery Key!

How do I use iCloud Keychain? I hear it stores all of 
my passwords and even my credit card information, 

but is it safe? Richard Harrison

 Passwords 
and more
iCloud Keychain stores your 
login details and passwords for 
websites you visit, as well as 
logins for Wi-Fi networks and 
credit card details (without the 
security codes).

 Safe devices
Only devices that are logged 
in with your iCloud details and 
have been approved by you will 
have access to the Keychain, so 
don’t worry!

 Safety first
You will need to sign in with your 
Apple ID every time you set up 
a new device on your Keychain, 
so no extra devices are added 
by accident.

 Switch it on
You can switch on iCloud 
Keychain in the iCloud section 
of the Settings app on your 
device. You’ll need to set it up 
with a security code the first 
time you use it.

I tried to

my card details on a 
website but the drop-
down menu wouldn’t 
appear. What’s 
happening? Charlotte Allen
First, you should check that your card 
details are definitely saved properly by 
opening Safari Preferences, choosing the 
AutoFill tab, and clicking Edit by Credit 
Cards. You will see a list of all your stored 
cards in this menu. If they are all there, it 
may just be that the website you were trying 
to use isn’t using a website form that is 
recognised by Safari. They are few and far 
between, as most sites have been updated 
and will work perfectly. 

Safari keeps
suggesting very 

complex passwords, 
but I’m worried I’ll forget 
them. Emily Lewis
Safari has a great feature that suggests a 
random password made up of letters and 
numbers that’s around 16 characters long, 
which is very secure. You can choose to 
have Safari remember the password for 
you so that next time you need to log in 
it’s filled in already. In order for this 
simplicity to continue on your other 
devices, turn on iCloud Keychain through 
iCloud settings on your other devices and 
the password will sync automatically to 
your iPhone and iPad, so that if you forget 
the long and complex password, you’ll still 
be able to log in.

Some websites still need to be 
updated to work with Safari

You can securely store 
passwords in iCloud Keychain
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The one-stop
column for
Genius advice
I heard that a lot of 
celebrities had their 
iCloud accounts hacked. 
Is my account in danger 
as well?
Possibly, although the 
hacking in that case 
was really just breaking 
through the celebs’ 
weak passwords. The 
best defence is a strong, 
complex password and 
two-factor authentication 
to make your account 
really secure.

Can my wife approve 
App Store purchases for 
our kids on her device, 
or am I the only one who 
can do it?
She certainly can – you 
just need to head into the 
Family section of iCloud’s 
settings and ensure she 
is listed as a Parent/
Guardian, then she’ll 
get approval requests as 
well as you.

When someone calls 
me, every device rings! 
It’s a nightmare! How 
can I stop this from 
happening?
This is Continuity in 
action, but we understand 
the frustration! On your 
iPad, open the FaceTime 
section of the Settings 
app. You can switch off 
the Calls from iPhone 
option here to stop it 
ringing. There’s a similar 
option in FaceTime 
Preferences on your Mac! 

Apple 
Expert

If you’re trying to set up a new iCloud device with two-factor authentication 
but a code isn’t coming through, get one manually in iCloud’s settings.

Is it safe to unlock my Mac 
with my Apple Watch? If so, 

how do I set it up? Sara Willis
The system uses Bluetooth to work out how far you are from 
your Mac, and unlocks it if you’re within a few metres, so it 
is pretty secure. To enable it open the General tab of System 
Preferences and make sure Enable Handoff is checked. Then 
open the Security & Privacy tab and check the relevant box 
to allow your Watch to unlock your Mac. Next time you wake 

your Mac from 
eep, it should 
utomatically log 

n – as long as 
ou’re close.

How can I control 
which passwords are 

shared in iCloud Keychain? 
I don’t want some to be 

Drew Burne
You can manage your passwords using Safari 
on your Mac. Open Safari’s Preferences and 
choose the AutoFill tab. You might have to input 
your Mac’s administrator password,
but once you’re in you’ll see 
every website with an associate
password. Click one to see the 
login details for the website – yo
can then get rid of any that you
don’t want to sync by clicking 
Remove in the bottom right. A 
few minutes later they should be
removed from your other device

My husband lost his phone last week and I’m worried if he 
gets a new one the same thing will happen. Is there any way 

to avoid this? Werner Greig

our Mac will only 
nlock if your Apple 
atch is within a 
w metres of it

 Family devices
If you set up an iCloud family, 
every device signed in with a 
family member’s Apple ID will 
appear in the list so you can find 
it easily.

 Get the app
The Find My iPhone app is free 
to download from the iOS App 
Store. Just search Find My 
iPhone on your iPhone or iPad 
and get it.

 Lock or erase
If your device is further away, 
you can put it into Lost Mode, 
effectively locking it, or erase 
all of its data if you think it’s 
gone for good and you want 
to stay secure.

 Ping it
If your device is nearby, you 
can use the Play Sound option 
to have it make a loud noise so 
you can hone in on its location.



24

Apply a creative vignette effect 
The term vignette refers to a lightening or darkening of the
colours and tones around the edges of a photograph. During
the early days of photography an uneven amount of light would
enter the edge of the lens, causing an inconsistent exposure.
This is why we tend to associate vignetted edges with old-
fashioned analogue prints. Despite being a lens-related artefact
to avoid, vignetting can creatively enhance a photo by evoking
a mood. Thanks to Apple’s Photos app we can give an image
a more retro look by deliberately adding a vignette effect to its
edges. We can also add atmosphere to our photographs by
darkening edges with a darker, more moody vignette.

Change a photograph’s mood in a variety of creative ways by adding a vignette

Add a retro-look vignette effectStep-by-step

Photos

Download available

Time needed

10

1 Access adjustments
Double-click on a photo that will suit a vintage 
look and then click the Edit Photo button in the 
top right of the workspace. Click the Adjust 
button to access the Adjustments panel.

2 Add vignette tools 
Click on the Add button in the top right of 
the Adjustments panel and choose Vignette 
from the pop-up menu. The Vignette slider will 
automatically darken the edges.  

3 Lighten the edges
Drag the Vignette slider left to lighten the 
tones and colours at the edges of the image. 
A Strength value of -0.70 mimics the uneven 
exposure caused by a primitive lens.

4 Refine the vignette 
Place the cursor on the right of the Vignette 
adjustment to access extra sliders. A Radius 
of 0.60 will expand the vignette into the image. 
Set Softness to 0.25 for a gentler blend.

5 Create retro colours
In the Color section, drop Saturation to -0.50 to 
produce washed-out colours that have faded 
over time. Set Cast to Sepia for a warm and 
friendly retro tint that evokes days gone by.

6 Dial it down 
When using the Vignette tool’s sliders it’s easy 
to go too far and create an over-the-top retro 
look. Reduce Strength to a more subtle -0.40 
to restore some of the blown-out edge details.
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Once you’ve added a vignette you can toggle the Vignette panel’s tick icon 

Lighten or darken edges

 Knowledge base

Peripheral Illumination

vignetted edges so that they 

1 Darken the edges 2 Cool the colours 

Add a 
spooky mood

“By darkening the edges of the 
frame you can add a more 
gloomy sense of menace”

 Copy Adjustments  Radius

 Adjust Strength 

 Access vignette tools 
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Search your library by objects
Thanks to our continually growing collection of digital photos
it can be a struggle to find particular pictures, even if they
are listed as chronological memories. Photos helps make
this tedious task less of a chore by analysing your library of
images to categorise their contents. The new Faces section
enables you to find favourite people with ease, but what’s less
obvious is that Photos can also recognise certain objects in a
shot if they fall into particular categories. So if you need to find
photographs of cats or cars then the Photos app can give you
a head-start in your search. Here’s how to make object-based
searches of your Photos library.

Use Photos’ object-analysing search tools to discover specific pictures with ease

Photos

Download available

Time needed

10

Find specific objects
Make a search based on visual analysis of a photo’s content

Knowledge base

Marvellous metadata 
Photos’ face and object-
recognition tools analyse 
pictures’ pixels to produce 
search results. Photos can also 
search an image file for other 
information, such as the GPS 
coordinates of where it was 
shot. Info attached to the file is 
referred to as metadata. When 
you add keywords, titles and a 
description to a photo this info 
is also stored in its metadata.

 Hide failures 
Here Photos can’t differentiate between 
a car and a steam engine cabin as it just 
sees a man looking out of a vehicle’s 
window. Right-click on a failed result 
and choose Hide 1 Photo to remove it 
from the current search results.

 Thumbnails
Click on a result in the Search 
field’s drop-down menu to 
display the object-based results 
as thumbnails. Double-click on 
a thumbnail for a closer look at 
the image.

 Results
As you type in an object-based 
search term a list of results will 
appear in this drop-down menu. 
The number of photos contained 
in each search result are also 
displayed here.

 Search field
To find photos that contain a specific subject 
(such as a car), type the desired subject 
in the Search field. Photos will search files 
visually for relevant objects, plus it will look for 
appropriate keywords in a file’s metadata. 
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Find photos using objectsStep-by-step

In theory Photos should be able to recognise thousands of objects in your 
goo.gl/xkZUDU.

Photos’ object recognition skills aren’t perfect. When we
searched for pictures of dogs many photos of cats also
appeared in our list of results. Object recognition is a useful
weapon in Photos’ arsenal but it can’t win the photo-finding
battle on its own. To help Photos find specific shots, it’s good
practice to add keywords to your images. You can then find
specific subjects much more easily in the future. 1 Add keywords

Click on a photograph to target it and then 
press Cmd+I to open the Info panel. Type in a 
description of the photo. Add as many keywords 
you need to describe the content. Think ‘what’, 
‘who’, ‘where’ and ‘when’. 

2 Search for keywords
Once you’ve added keywords and a description 
to an image’s metadata, you can use the Search 
field to display any photos containing those 
keywords. This is very useful if an object- or 
place-based search fails to find your desired shot.

Get clever 
with keywords

“To help Photos find specific 
shots, it’s good practice to add 
keywords to your images”

1 Scan the library 
For object recognition to work, Photos needs 
time to scan your library. It will also scan new 
photos as they are added, so they may not 
immediately show up in an object search.

2 Search for people
To check that Photos has been analysing your 
photos for visual content, click on the People 
icon. Photos will present you with thumbnails 
containing shots of any people it can find. 

3 Object recognition 
As well as recognising individual faces in your 
collection of images, Photos can also recognise 
a wide range of objects (though there is no 
Object panel in the Albums section). 

4 Search for objects 
To try out an object-based search, go to the 
Albums section and click on All Photos to 
display everything in your library. Go to the 
Search field and type in an object such as ‘cat’.

5 Choose a Category
A drop-down list will appear based on the 
search term. This list includes Categories (such 
as Cat, Dog, Car). It will also include any files 
that contain the searched object as a keyword.

6 View results
Click a Category to display all the files in your 
library that contain that particular object. 
Photos can also recognise certain objects 
(including cats!) in video files too. 
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Master iMovie’s Precision Editor
When filming a sporting activity, you can change your camera
position to capture a subject using different angles and shot
sizes. If the action is repetitive you can cut between different
takes to add visual variety to the project. We’ll show you how
to use iMovie’s frame-accurate Precision Editor to cut a series
of action clips together, to make the subject’s action match
perfectly when we cut (or mix) from one clip to the next. This
creates a seamless sequence of shots. You can also fine-tune
the edit point to cut earlier or later to the next shot. Thanks to
the Precision Editor we can make the juggler in our supplied
footage look much more proficient by cutting out mistakes.

Achieve frame-accurate editing to create smooth-flowing sequences

Produce frame-accurate editsStep-by-step

iMovie

Download available

Time needed

10

1 Import clips 
Go to Projects and click Create New>Movie. 
Go to File>New Event. Label it ‘Juggling Event’. 
Click Import Media. Browse to our supplied 
source clips. Click Import Selected.

2 Add clips to timeline
Shift-click to select Shot01, Shot02 and Shot03 
in the browser. Click Shot03’s + icon to add the 
three selected clips to the timeline. The three 
shots will appear in consecutive order.

3 View the clips 
Play the footage. As the shots are unedited the 
action doesn’t flow as smoothly as it could. At 
the end of Shot02 the juggler fails to pull off a 
trick that he performs successfully in Shot03.

4 Add edit point
Click on Shot01. Choose Window>Show 
Precision Editor. Click the grey rectangular Add 
Edit Point icon above Shot02. Shot01 will jump 
to the top. Shot02 will stay on the bottom.

5 Set Shot01 out-point 
Shot01 on the top is the outgoing clip. Shot02 
below is the incoming clip. Drag Shot01’s grey 
vertical edit point bar until the red-handled club 
is about to land in the juggler’s right hand.

6 Set Shot02 in-point
On the bottom track drag Shot02’s edit point bar 
to fine-tune where it starts (its in-point). Place the 
red-handled club so that it matches the position 
of the same club in Shot01’s out-point.
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To quickly access the Precision Editor, double-click on the end or beginning 
of a clip in the timeline.

Master the Precision Editor
Fine-tune an edit point’s cuts and transitions

Knowledge base

Split edit
When you cut between two
clips the audio will cut too. This
can make the cuts appear more
abrupt. When using the Precision
Editor you can drag a clip’s
audio edit handle independently
of its video edit handle. This
enables you to make sound from
one clip overlap another, which
helps merge the adjacent clips
together in a less jarring way.

Play back the edit
To see how your cuts are shaping
up click in this middle grey bar
between the outgoing and incoming
clips. Tap the Spacebar to play the
sequence and see the cuts made
using the edit handle.

Refine an in-point
You can refine the incoming clip’s
in-point by dragging its edit handle
left or right. Here we can match the
action in the outgoing close-up so
that the juggler’s moves continue
smoothly in the incoming wide-shot.

Add edit point
When you click a grey rectangle
above a clip it adds an adjustable
edit point to two adjacent clips.
The outgoing clip appears in
the top track. The incoming clip
appears in the bottom track.

Use a transition
Once you’ve matched the
movement between two cuts you
can close it and add a transition
between an edit point. You can
then pop back into the Precision
Editor and fine-tune the position
and duration of the transition.

 Refine an out-point
Drag an outgoing clip’s edit handle left to 
specify an earlier out-point for the clip. Drag 
the edit handle right to create a later out-
point. The out-point frame selected by the edit 
handle will appear in the Viewer.

7 Check continuity 
Play the sequence and the action will flow 
smoothly between Shot01’s trimmed out-point 
and Shot02’s trimmed in-point. Click the grey 
rectangular Add Edit Point icon above Shot03.

8 Match the action 
In Shot02 the juggler fails a trick. Drag Shot02’s 
edit point until the three clubs have just left the 
juggler’s right hand. Drag Shot03’s edit point so 
the action matches in the wider shot.

9 Add a dissolve 
Click Close Precision Editor. The action will flow 
smoothly (and without juggling errors). You can 
drop a Dissolve transition between two cuts for 
a gentler blend between the matched moves.
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Top 10
keyboard
shortcuts

As with most modern software apps, GarageBand has to vie
for our increasingly precious time and attention. Its intuitive
music-making features need to do more for us, while still
providing enough quick-fire usability and accessibility to
streamline operations. Without the benefit of touch controls,
GarageBand on the desktop provides keyboard shortcut
commands to speed up workflow and keep core features
at your fingertips. Power users will doubtlessly know the
benefit of navigating the workspace this way, toggling
panels open, performing track edits and much more.
However, composers of all levels will appreciate the inherent
timesaving advantages with learning just a handful of the
most essential keystrokes.

Take GarageBand productivity
to the next level with these
essential keystroke commands

Delete 
automations

Advanced users familiar 
with editing track 

automations will know 
that manipulating points 

can be fiddly. First, show 
or hide automations with 

the A key before using 
the moderately dexterous 

Ctrl+Shift+Cmd+Delete 
to remove all automations 

on a selected track.

Disappearing 
acts

Within a busy studio 
desktop it can be 

useful to rapidly vanish 
GarageBand without 

losing it completely. To 
minimise the window 

without the mouse simply 
press Cmd+M or Cmd+H 

to hide GarageBand 
and reach whatever 

lies behind.

Mute/solo 
toggling

Muting and soloing 
multiple tracks via 

individual header buttons 
is very time intensive. 

This can be alleviated by 
hitting M or S on selected 

tracks as a basic shortcut. 
A more advanced one 

prefixes these with 
Ctrl+Alt+Cmd to unmute 

or unsolo all tracks. 

Transpose 
like pros

Editing notes within 
MIDI regions can be 
tricky when shifting 

them accurately along 
the piano roll. When 

transposing selections, 
press Alt+Up/Down 

arrows to shift a semitone 
either way. Shift up and 

down octaves instead 
with Alt+Shift+Up/Down.

Quick
recording

To quickly start and
indeed stop recording

into a track, simply tap
the R key. Especially

useful when stood with
a guitar hanging from
your neck, associated

keystrokes include C for
toggling on/off the

cycle region.

Instant tracks
If you need to add a new track nice 
and quick, there are three shortcuts 
worth knowing featuring the Opt/Alt 
key. With Alt+Cmd+N you can bring 

up the new track dialogue to choose, 
or modify with the A or S keys to 

add new audio or software 
instrument tracks. 

GarageBand
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Play piano with keys
Use the keyboard to play software instruments in the Musical Typing window

 Musical Typing
Open the window via Window>Show 
Musical Typing or with Cmd+K, floating 
the panel over the workspace. Musical 
Typing enables piano notes to be 
played by clicking the on-screen keys 
or via the keyboard as labelled.

 Pitch Bend 
and Modulation
Pressing the 1 (minus) or 2 (plus) keys 
will bend a note down or up for the 
duration held. Modulation is toggled 
on/off with the 3 key, with keys 4-8 
controlling the mod wheel min-max. 

 Piano keys
There are 18 piano keys representing 
the current section of the keyboard 
shown above. The keys from A-K span 
an octave of 12 notes, alongside those 
for controlling additional functions. 

 Octaves and Velocity
You can quickly cycle up and down the 
selected keyboard octaves, low to high 
and left to right, by pressing the Y or X 
keys. In addition you can lower or raise 
the key velocity using C or V.  

Swifter saving
One of the most 
important things you can 
forget when busy and 
short of time is actually 
periodically saving your 
precious project. You can 
shortcut a quick save of 
course with the Cmd+S 
combination, or initiate 
a Save As to perhaps 
commit a new version to 
disk with Shift+Cmd+S. 

Double rush
Duplicating tracks is 
useful for doubling up 
when arranging. To 
duplicate a selected track
you can use Cmd+D, 
while Cmd+C and 
Cmd+V perform basic 
copy/paste operations. 
Selecting a region and 
holding Alt allows a 
duplicate to be dragged 
out and dropped.

Zooming 
marvellous 
Getting up close and 
personal with your music 
is crucial when it comes 
to making editing tweaks. 
For this you need zoom, 
both within the tracks 
workspace or Editor 
panes, which can be 
achieved very simply via 
Cmd+Left arrow to zoom 
out or Cmd+Right arrow 
to zoom in. 

Show panels
Showing and hiding the myriad 
of panels within the GarageBand 
workspace is one of the first basic 
shortcut sets anyone should learn. 
This includes showing or hiding 
Smart Controls with B, the Loop 
Browser with O, the Library with Y, the 
Piano Roll with P and the Editor with E. 

One of the most memorable GarageBand shortcuts is perhaps the one you’ll 
use the most, with the Spacebar starting and stopping project playback. 

 Knowledge base

Force Touch 
with trackpad
If you have a trackpad 
connected with Force Touch 
capability, GarageBand provides 
additional function access 
based on force clicking interface 
elements. These include the 
ability to create new MIDI 
regions, add audio files, open 
new tracks, add Editor notes 
and insert automation points.
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Unlock Logic’s Advanced Tools
Logic Pro X is a full-blown music-making powerhouse for
professionals, containing all the tools necessary to create
top-notch musical masterpieces, so it’s easy to understand
why it’s so popular with famous names like Calvin Harris and
Jonas Blue. However, some of the more advanced professional
features are hidden away in a bid to make the software less
intimidating for new users. Thoughtful though this approach
may be, it can inhibit things if you’re trying to perform a certain
function only to find that it’s apparently missing from the app.
So the question is, how do you configure the software so that
all the high-end stuff you might need is accessible? Read on…

Discover a world of hidden talents with Logic’s Advanced Tools setting

Logic Pro X

Download available

Time needed

20

Advance and be recognised
Unlock Logic’s treasury of advanced features

Knowledge base

Additional options
You can use these checkboxes 
to select only the options 
that make sense for the type 
of project you’re currently 
working on. For instance, if 
you’re working in stereo, you 
can uncheck the Surround 
checkbox to hide away all of the 
unnecessary surround mixing 
options that you won’t need 
if you only have two speakers 
connected to your system.

 Disable/Enable
Use the buttons in the bottom left-hand 
corner of the Advanced Tools control 
panel to enable or disable all 
the additional options at once. These 
can only be selected with Advanced 
Tools enabled.

 Take control
Control surfaces are hardware 
devices that use physical 
controllers such as knobs, buttons 
and faders to control Logic’s 
features. This option allows them 
to be precisely configured.

 Destructive 
audio editing
Enabled by ticking the Audio 
checkbox, destructive editing is 
the kind that permanently alters 
the structure of an audio file on the 
hard disk. 

 MIDI 
Checking this box enables access to the MIDI 
Environment, the mystical place that controls 
the flow of MIDI data within Logic. Pretty 
advanced stuff!
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Unlock Advanced Tools and additional editorsStep-by-step

1 Default view
When Logic ships, Advanced Tools are usually 
turned off by default, giving the app a very 
similar look and feel to GarageBand to make 
GarageBand users feel at ease.

2 Window of opportunity
To get an idea of what features are initially 
available in this mode, click on the Window 
menu. The only editor available from here at this 
point is the main Arrange window.

3 Access panel
To access the Advanced Tools control panel, 
just select the Advanced Tools option from the 
Logic Pro X>Preferences menu. The panel will 
open up.

4 Big tick
Turn on all the additional features by ticking the 
Show Advanced Tools checkbox. Logic’s main 
window will close briefly and reopen with the 
new advanced interface.

5 New look
Click the red button to close the window. The 
most obvious change is that the fake wooden 
end cheeks have gone, and Logic now looks 
like a totally different animal.

6 On the menu
Checking the Window menu now reveals a 
different story – lots of different editors are now 
accessible from this list, such as the Score and 
Audio File editors.

7 Special events
A new Event List Editor button has appeared in 
the top-right corner in the toolbar. This enables 
you to view all MIDI data within the selected 
MIDI region as a chronological list.

8 Tooled up
This extra button on the left of the main toolbar 
reveals a second toolbar, offering one-click 
shortcut access to some of the more often-
used editing functions. 

9 Project management
Project handling becomes more versatile in 
Advanced mode. You can save alternative 
versions of projects that can be consolidated 
and exported as new projects.
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Master compositing techniques
Compositing is the creative art of combining two video clips
together to produce a more interesting juxtaposition. After
filming your subject against a coloured backdrop you can
use Final Cut Pro’s keying tools to hide the background and
replace it with another video clip. However, there are many
pitfalls to overcome in order to create a clean composite clip.
If your coloured backdrop is unevenly lit then patches of colour
may remain visible in the composite footage. Your foreground
subject may also suffer from holes that reveal parts of the
underlying video clip. Here’s how to create a cleaner composite
and remove common compositing artefacts.

Learn how to combine two video layers together and remove compositing artefacts

Create a clean composite imageStep-by-step

Final Cut Pro X

Download available

Time needed

20

1 Add clips to timeline
Drag your background clip to the timeline, then 
drag your bluescreen clip to the layer above. 
Here we don’t have enough blue card to fill the 
frame so there will be a hole in our composite.

2 Insert key effect
Go to the Keying section of the Effects browser. 
Drag Keyer onto the top clip. The blue backdrop 
will vanish. The lack of blue card at the left 
means some of the background clip is hidden.

3 Identify problem areas
In the Video Inspector’s Keyer section, set View 
to Matte. White areas will remain 100% solid, 
black areas will be 100% transparent and grey 
areas will cause a patchy mix between layers.

4 Refine the key effect
Choose the Sample Color tool. Draw rectangles 
over patchy grey backdrop areas to refine the 
key. Sample backdrop colours at different parts 
of the timeline if the lighting changes.

5 Fill holes
Our example clip still has grey patches within 
the figure. These will create holes in his head. 
Drag the Keyer’s Fill Holes slider right until the 
head is a solid white.

6 Soften the edges
In the Keyer’s View section click on Composite 
to see both clip layers. Toggle open Matte 
Tools. Drag Soften right to reduce sharp edges. 
Drag Shrink/Expand left to hide colour fringes.
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You can buy a large cheap blue or green backdrop card from a stationary 
shop, perfect for producing talking-head style composite images.

Key out a coloured backdrop

Knowledge base

Bluescreen on
a budget
We shot our bluescreen footage
by hanging a blue sheet of card
behind our subject. We filmed
the subject indoors so that
the card remained static (and

constant throughout the clip’s
duration). We positioned

holes in the composite image.

Matte tools

you can use the Matte tools to refine
the edge around your subject. Here

edge to make them look less cut-out.

Keyer

backdrop, you can automatically
replace the top layer clip’s

Sample Color
If lighting changes during the clip
then the backdrop’s keying colour

appear. Use the Sample Color tool
to select any problem areas so that
they become totally transparent.

 Shape Mask 

subject’s background then you can make the 

Mask. Make sure that the subject’s hand 

7 Check the matte
Go back to the Matte view and scrub through 
the footage to check the head remains a solid 
white while the background is patch free. You’ll 
see the subject’s softer edges more clearly too.

8 Zoom out
Go back to Composite view. Set the Viewer to 
show the footage at 50% so you can see some 
space around it. In the Effects browser’s Mask 
section, drag Draw Mask onto the top layer.

9 Draw points 
Click to place anchor points that draw a 
selection over the unwanted area. Place the last 
point on the first. In the Inspector’s Draw Mask 
section, tick the Invert Mask box. 
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Filter out spam with SpamSieve
Junk email messages are an irritating problem for many
people and our inboxes fill with spam every day. Deleting them
takes time and effort that could be used for something more
productive. Some email services provide spam filtering and
Apple Mail has a spam filter, but is junk still getting through?

SpamSieve is a powerful plug-in for Mail and other apps that
provides more powerful and more accurate spam filtering. It
comes with a comprehensive set of rules for detecting spam
and once installed, you might never see junk messages again.
Download the plug-in from c-command.com/spamsieve and
follow our guide to set it up and train it to recognise spam.

Use SpamSieve to automatically sort the good emails from the bad ones

SpamSieve

Download available

Time needed

10

SpamSieve settings
Get to know SpamSieve and block junk mail for good

Knowledge base

Filter email
Mail has built-in spam filters 
and also provides a facility 
for creating rules to deal with 
incoming emails. You could use 
these together to filter junk, but it 
would require a lot of time, effort 
and some technical knowledge. 
SpamSieve does it all for you 
and makes the task easy. Simply 
install it and let it do its thing. It 
just works.

 Spam folder
When SpamSieve uses its collection 
of rules to determine that an email is 
spam, it moves it from the inbox into 
the Spam folder. You can then click 
Spam to see all the emails that have 
been caught.

 Add a rule
SpamSieve’s rules are 
comprehensive and are fine for 
most people. However, experts 
can add their own rules to deal 
with incoming messages. Click this 
menu and then enter the rule.

 Check the status
In the Filter menu is an option to 
show the Statistics window. Here 
you can check on SpamSieve’s 
performance and see how many 
emails it has blocked and let 
through. It’s interesting.

 The Blocklist
Open the Filter menu and click Show Blocklist 
to see a list of the rules used to block spam 
emails. You can delete any rules that actually 
mistake good emails for bad ones in the 
window that appears.
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Eliminate spam with SpamSieveStep-by-step

SpamSieve has a good Help menu that has everything you need to 
know and more. Check it out if you want to go further than the basics.

SpamSieve works quite well right from the start, but it is not
perfect and it must be trained in order for it to learn which
emails you class as spam, and which you do not. You need to
spend some time with it at first, showing it what you consider
to be good emails and what you consider to be unwanted
spam. By doing this, the spam filters in the plug-in learn to
recognise the characteristics of messages you want to see
and those that you don’t. By doing this it will whitelist or
blacklist senders, and recognise content that is unwanted. 1 Teach it lessons

Select the inbox and then select one or more 
emails that are spam. The more you choose, the 
better SpamSieve will learn. Select SpamSieve - 
Train as Spam in the Message menu. Select good 
emails and then Train as Good.

2 Tweak the settings
Select Preferences in the SpamSieve menu and 
choose the Advanced tab. Use the slider to 
make the spam detection more conservative or 
aggressive, depending on how much spam is 
getting through. Combine this with training.

Train SpamSieve

“The spam filters learn to 
recognise the characteristics 
of messages you want to see”

1 Install the plug-in
After downloading SpamSieve and moving the 
app to the Applications folder, run it. Before 
doing anything else, go to the SpamSieve 
menu and click Install Apple Mail Plug-in.

2 Check the install
Has SpamSieve installed correctly? Open the 
Mail app and then look in the Message menu. 
There are three new SpamSieve menu options 
for settings and training.

3 Create a mailbox
SpamSieve requires a mailbox called Spam. 
Open the Mailbox menu and select New 
Mailbox. Set the location to On My Mac and the 
name to Spam (with a capital first letter).

4 View the rules
Go to the Mail menu and click Preferences. 
Select the Rules tab and the rules for sorting 
incoming emails are listed. This is how 
SpamSieve filters emails. Click Add Rule.

5 Create a rule
Name it SpamSieve and select Every Message 
in the options below. Set the action to Move 
Message to mailbox Spam. After creating it, 
drag it to the top of the rules list.

6 Disable Junk Mail
SpamSieve replaces Mail’s spam filtering, so 
select the Junk Mail tab and clear the tick 
against ‘Trust junk mail headers in messages’. 
Clear ‘Enable junk mail filtering’ too.
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Use keyboard shortcuts with iTunes
For many Apple users there’s little better than having music
booming away while you work. Much of the time this soundtrack
will be provided by iTunes, but when multitasking between active
applications on macOS it can become a headache keeping
control of what’s playing. Although most of our keyboards sport
function hotkeys for play/pause, skip and volume, more useful
commands are natively limited – which is where SizzlingKeys
helps out. SizzlingKeys is a lightweight app available via the Mac
App Store that utilises keyboard shortcuts without switching
from the current foreground application. With it you can
effortlessly switch playlists, search your library and much more.

With handy app SizzlingKeys you can control iTunes without leaving your current app

Navigate iTunes with keyboard shortcutsStep-by-step

SizzlingKeys

Download available

Time needed

10

1 Playback defaults 
With iTunes and SizzlingKeys launched, the 
Basic Controls tab defines default playback 
commands such as play/pause, previous/next, 
volume, mute and opening iTunes itself.

2 Custom shortcuts 
Basic Controls start by using the (Fn+)F6-F12 
keys with Shift and Ctrl modifiers. Customise 
these by simply clicking the button and entering 
alternatives into the prompt.

3 Show playlists 
A key extra feature is the ability to browse 
between iTunes playlists. Press the default 
Fn+F6 shortcut to reveal a pop-up playlist 
menu that can be searched and selected.

4 Song search 
Alternatively, hitting the Shift+Fn+F6 default 
shortcut opens a search box where a whole 
iTunes library can be viewed before choosing to 
play a song or add to your queue.

5 Quick ratings 
SizzlingKeys enables shortcuts for rating songs 
as you listen. The Ratings tab toggles this 
on and defines them by default as Ctrl+(0-5), 
denoting the amount of stars.

6 Floater options 
The Floater box displays current track 
selections and actions. Use the Floater tab 
to define how long and when it should show, 
along with how it should look on screen.
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Signposting the Sizzle

 Knowledge base

Function keys

1 Download the trial 

yellowmug.
com/sk4it

2 Buy via App Store 

SizzlingKeys: 
Free versus Pro 

“The registered version adds 
‘pro’ commands within the Pro 
tab from the main window”

 Window tabs

 Customisable 
shortcuts

 Floating window

 SizzlingKeys menu bar 
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Secure files on a USB flash drive
FileVault can be used to encrypt the contents of the Mac’s
internal disk, but what about external disks? Files you back up
to external drives and files you carry in your pocket on USB
flash drives are at risk. USB sticks are very easily lost and you
don’t want anyone to be able to access the files on them. You
should securely encrypt the contents so no one can access
them without a password. There are two ways to encrypt
files on an external drive or USB stick and it takes just a few
minutes to make them secure. We’ll show you how to create
encrypted disk image files and then how to encrypt the whole
drive. Plug in your USB flash drive and let’s get started.

USB sticks are easily lost, so here’s how to make sure no one can access the files on it

Disk Utility

Download available

Time needed

10

Create encrypted storage

Knowledge base

Encryption options
Two encryption methods are 
described here and you can 
either create an encrypted DMG 
file or encrypt the whole drive. 
Which is best? A DMG file can 
be copied, moved to another 
disk, backed up, emailed and so 
on. This makes it more flexible 
than encrypting the whole disk. 
However, whole disk encryption 
is simpler to set up and use. 

 Pick the format
Set the Image Format to read/write 
disk image. This makes the disk image 
work like a disk drive and you can use 
it to save files, read files, delete them 
and so on.

 Select the encryption
A disk image file is not encrypted 
by default and anyone can open 
them. Make sure you select one 
of the encryption options so that 
your files cannot be accessed by 
anyone else.

 Set the size
Enter the size of the DMG file. 
There is no size limit, but you might 
want to leave some space on the 
USB flash drive for other files that 
do not need to be encrypted.

 Where it’s saved
Encrypted disk image files can be saved 
anywhere. Either create it on the USB flash 
drive or create it on the desktop and copy it 
to the drive afterwards. No-one can open it 
without the password.
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128-bit and 256-bit AES encryption are two widely used encryption 

Securely store your filesStep-by-step

1 Start Disk Utility
Open the Utilities folder and run Disk Utility. Go 
to the File menu and select New Image>Blank 
Image. This menu option is used to create a 
new empty DMG file on the disk.

2 Set the location
Enter the filename for the DMG file in the Save 
As box at the top and then click Where to 
choose where to save it. Select the USB flash 
drive in the list of devices.

3 Select the encryption
Enter a name and size for the DMG and then 
click Encryption. There are two options; 128-bit 
AES is recommended because it is faster than 
256-bit and is secure enough.

4 Pick a password
After selecting the encryption type you must 
then enter a password, twice in case of typing 
slips. Do not forget this because it is the only 
way to access your files.

5 Save your files
Click the Save button to create the encrypted 
DMG file on the USB flash drive. A Finder 
window is automatically opened afterwards. 
Use it like a disk drive to store files.

6 Lock your files
After copying files to the DMG file, Ctrl+click it 
and select Eject or drag the icon to the Trash 
to securely lock it. Double-click it and enter the 
password to reopen it.

7 Erase the drive
It is also possible to encrypt the whole USB 
flash drive. Select it in Disk Utility and click 
Erase. Set the format to Mac OS Extended and 
the scheme to GUID Partition Map.

8 Encrypt it
After formatting the USB flash drive, Ctrl+click 
the icon on the desktop and select the Encrypt 
option. Only disks that have been correctly 
formatted can be encrypted.

9 Set the password
Enter the password twice. You will need 
to enter it whenever the USB flash drive is 
plugged into the Mac, so don’t forget it. Enter 
a password hint and click Encrypt Disk.
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Sync files between devices for free
There are many services available that enable you to
synchronise files between your devices so that you can access
them anywhere, but most either come with restrictions on the
number of files you can store or with a monthly subscription
charge. This is great if you have a need to synchronise files
every day, but for occasional use and the peace of mind that
always having access to your important files brings, you may
want to look at Resilio Sync. There are two plans available
ranging from free to a one-time fee of $39.99, and a business
plan that can be used by multiple users with premium support
as an added incentive.

You can now sync files between multiple devices without having to pay a monthly charge

Sync your files everywhereStep-by-step

Resilio Sync

Download available

Time needed

10

1 Download the application 
Go to resilio.com and download and install the 
macOS app. You can also head over to the iOS 
App Store and download the iPhone version. 
Both apps recognise who you are.

2 Add a folder 
Once you have completed the minimal setup, 
you should click the Add Folder option at the 
top. Select Standard Folder and then navigate 
to the one you need to sync. 

3 Let it sync 
After the folder has been added, click the three 
dots on the right to check the status. Let the 
synchronisation complete before you go any 
further. It is worth the wait. 

4 Add a device 
Click the My devices icon at the top and then 
click Link device at the bottom to add your 
iPhone or iPad. You can scan a QR code with 
your iPhone camera to link them. 

5 Device syncing
If you have a Pro account and have followed 
the previous step, you will now be able to 
access the files on both devices at any time. It’s 
close to being fully automatic. 

6 Check the history 
The small clock icon at the top can be clicked 
to check the history of your syncing. The app is 
fully secure, but this is useful as an extra check 
if you want to be sure. 
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The Pro version lets you control bandwidth usage to ensure that your other 

Familiar syncing 
Find your way around the minimalist Resilio Sync interface

 Knowledge base

Everything everywhere
Resilio Sync supports all major 
computing platforms including 
macOS, iOS, Windows, Linux, 
Android and popular NAS 

worry that your needs will not 
be met, and you can even 
revoke file access and change 
permissions wherever you are in 
order to ensure the best possible 

install the app for you to authorise them, but this potentially
gives you the ability to share files in the future with a couple

able to collaborate on projects using just Resilio Sync, and as
1 Choose your method 
When you click the Share icon next to a folder, 
you will be offered the ability to send an email 

The available choices will be useful in a variety 

2 An email share 
The recipient will receive an email detailing what 

entire process is designed for efficiency and there 
is sense of security, careful thinking and reserved 

Share files 
with others

“You can both remain secure 
and be able to collaborate on 
projects using just Resilio Sync”

 Real-time sync 

devices, you will be surprised at 

can effectively carry one computer 
anywhere using multiple platforms 

 Minimal preferences 
There are some useful preferences 
included to help you manage how 
files are synchronised, but on the 
whole you can leave most options 
as they are and enjoy the benefits 

 Your files 
When you need to access your 
files, you will still see the familiar 

merely acts as a secure conduit 
to allow the syncing of your most 

 Don’t overdo it 

The real benefits here come with the speed 
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Mount, unmount and eject drives
Plug in an external drive or open a disk image and Finder
mounts it as a volume. It can then be used to load and save
files. When you have finished with a drive or disk image, it can
be dragged to the Trash to unmount it. Mountain is a great app
that does this and more, and it makes the process of mounting
and unmounting disks far easier and quicker.

Download the free trial from appgineers.de/mountain. Unzip
it and drag the app to the Applications folder. Run it and you
can use it to mount and unmount volumes more easily than
with Finder. Everything is on a simple menu bar icon and even
whole groups of volumes can be mounted and unmounted.

Simplify mounting and unmounting drives with Mountain for macOS

Mountain

Download available

Time needed

10

Mountain’s best features
The simple controls enable you to easily manage volumes

Knowledge base

Volumes, disks 
and drives
What is a volume, a disk and 
a drive? A disk and a drive are 
the same thing. It is the physical 
unit of storage and it can be a 
mechanical disk or a solid state 
drive. A disk’s storage space can 
be divided into one, two, three 
or more parts called partitions. 
These are Mac volumes.

 Unmounting errors
You might see a message like this when 
a volume is unmounted. If one or more 
apps are using a volume it cannot be 
unmounted and there is an option to 
quit the app.

 Unmount all
This menu option, Unmount All 
and Sleep, will unmount all of the 
volumes it can (although some 
might be protected, like the Mac’s 
internal disk), and then put your 
machine to sleep.

 Mount the unmounted
Unmounted volumes disappear 
from the desktop, but Mountain 
keeps track of them and they are 
listed in this section of the menu. 
Click the button to mount the 
volume again.

 Unmount groups
Each volume has its own button to unmount 
it, but volumes are organised into groups. 
Click the group button to unmount all of the 
volumes in the group. It’s quick and easy.
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Manage disk volumes using MountainStep-by-step

Before a disk can be used, it must be mounted. This means reading the 
type, format and partitions, adding them to the list of volumes in Finder.

Mountain has a variety of options that enable you to
customise the way it works, and after getting to know its
main features you should go to Preferences in the menu.
There are six tabs and some of them are packed with options.
We will look at two of the tabs here, but we recommend you
look at them all. In the General tab you can choose whether
Mountain starts automatically when you log in to the Mac. 1 Advanced settings

Select Preferences in the Mountain menu and 
then select the Advanced tab. Among the settings 
are options to eject the entire disk when a volume 
is unmounted. A disk might contain several 
volumes, so it’s your choice.

2 Customise volumes
Select the Customize tab and you can choose 
what happens with each volume. For example, 
you might want to protect a volume and prevent it 
from being unmounted. Select a volume and tick 
the options you want.

Configure 
Mountain

“Mountain has a variety of 
options that enable you to 
customise the way it works”

1 Show the menu
Mountain adds a menu bar icon and when 
clicked, it shows a list of all the volumes – 
drives and disk images. Click the Up arrow to 
unmount a volume you have finished with.

2 Remove a volume
When the volume is unmounted, the icon is 
removed from the desktop and a notification is 
displayed. The volume remains on the Mountain 
menu so it can be mounted again.

3 Open a volume
Disk icons do not have to appear on the 
desktop and they can be hidden in Finder 
Preferences. If you don’t have icons, click a 
volume on the Mountain menu to access it.

4 Browse the files
Opening a volume from the Mountain menu 
opens a Finder window just as if you had 
clicked the desktop icon. Although unmounted 
volumes appear on the menu, they won’t open.

5 Mount them all
If you have unmounted all the USB volumes, 
normally you would need to unplug them and 
plug them back in. Instead, go to the Mountain 
menu and click Remount USB Volumes.

6 Connect to server
Mountain can also be used to connect to 
servers on the network, such as NAS drives. 
Click the Mountain button, select Connect to 
Server and enter the server address or name.



Siri is extremely popular on 
mobile devices and the 
reasons for this are 
obvious. It can be used 

when you are doing other things that 
require the use of your hands, and in 
many cases it can undertake certain 
tasks more efficiently than by using 
apps or a web browser. With the 
addition of Siri in macOS Sierra, the 
same functionality is now available on 
the desktop and Apple has taken time 
to ensure that the main Siri function is 
just as invisible as it is on an iPhone 
until you need to use it. Potentially, Siri 
can be utilised as part of a workflow 
when you are working on long projects 
and if you take the time to explore what 
it can be used for, you will likely find 

yourself using it multiple times a 
day. The fact that it takes up a small 
amount of pixelated real estate on 
larger-screened devices should not 
be a concern, because it is designed 
to work alongside apps rather than 
completely replace the Mac experience, 
and much detail is still presented in the 
results. Whether you are using an 
iPhone, an iPad or an iMac, Siri will be 
there ready to offer the exact same 
experience and to interact with many 
of the main functions built into each 
device. It can actually control system 
settings, deal with native app functions 
and then take things further by 
searching the web, setting reminders, 
checking the weather and helping with 
almost anything else you need to do. 

SIRI 
MASTERCLASS

Everything you didn’t know you could ask
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The beauty of Siri 
on a Mac is that 
it can be brought 
to the foreground 
at any time by a 
simple keyboard 
shortcut. You 
can then ask a 
question and the 
answer will be 
presented within 
the Siri window 
in seconds.

Ask Siri a question on your Mac

1 Open Siri
Use a keyboard shortcut or click the Siri 
icon to bring up a small panel on the main 
screen. Siri will appear on screen no matter 
what you are doing at the current time, but 
doesn’t get in the way.

2 Ask the question
You can now ask any question you like and 
the answer will be presented within the Siri 
window for you to either copy or simply 
remember as needed. At no point will Siri 
dominate the entire screen.

3 Accuracy and humour
The answer will be spoken aloud and also 
presented as text or images, but sometimes 
Siri may throw in some humour to add a little 
extra personality to the experience. It’s an 
absorbing feature to use each day.



Amazing ways to 
use Siri in Sierra
Your desktop assistant can 
help in a multitude of tasks

 Open apps

using Siri, which should 
save some messing about 
finding icons or navigating 
to the Dock.

Click the mic
Select the microphone

respond. It never gets in

get on with other things.

 Find local files
Siri has been designed to 
work with the core Sierra 

or other reference in 
seconds. The results are 

 Add new 
reminders
Siri on Sierra works well with 

 Play music

a song title or artist and 
a small window will 
appear using iTunes to 

 Search the web
You could open up 
Safari, click in the top bar 

something on the web, 
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Set it up



Control your Mac
Tweak key system settings by voice command

Siri on your desktop offers more than
searching for information and getting
answers to questions. It has been

designed to also work with specific settings on
the Mac, which means that you can control

certain aspects of the hardware instead of having 
to go to System Preferences. We will show you
some of the more obvious things that you can
do, but experimenting with Siri may pop up some 
surprising system-based functionality.
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Siri masterclass

Pin 
searches to 
Notification 
Centre
Search with Siri and 
save the results for later

1 Open apps
It’s easy to open apps with Siri
and all you need to do is say
“Open...” followed by the
app name. You will need to be
specific with the name for it to
work as it should.

4 Free iCloud space?
You can also ask Siri how much
iCloud space you have free and it will
offer a similar dialogue to what you
see when checking Mac space. It is
a very handy additional feature.

2 Change the volume
You can alter the volume by saying
“Turn the volume...”
and “up” or “down” plus the
number of levels you want to tweak.
Perfect if your keyboard has no
volume shortcuts.

5 Change your wallpaper
Almost every part of your macOS
System Preferences can be directly
accessed using Siri. Simply present
a natural instruction to Siri and the
relevant panel will immediately be
opened for you.

3 Check free space
If you ask Siri how much free space
you have, it will be displayed along
with an option to Show Details. One
more click will open the About This
Mac screen.

6 Manage connections 
Siri can also turn wireless 
connections on and off, such as 
Bluetooth. Remember that when 
some of these are off, certain 
accessories may stop working.

Siri on a Mac is not just about 
searching for something or 
opening a hardware feature. It 
can also be useful for gathering 
data for research purposes 
or for referring to later. With 
just one click you can add 
Siri results to the Notification 
Centre in an instant.

1 Ask the 
question
Open Siri and 
ask a question as 
normal. Depending 
on what you are 
asking for, you 
should see a panel 
appear with a 
small + icon 
within it. Some 
info is included.

2 Pin result
Click the + 
icon and it will 
automatically 
be added to 
the Notification 
Centre. You will 
see the answer at 
the top above any 
other content that 
usually resides 
within it.

3 See 
more detail
Click Show 
more if you want 
to see more 
information within 
the Notification 
Centre panel. You 
can also click See 
full article to jump 
straight to a web 
view in Safari.



One of the major benefits of Siri 
is its ability to work with other 
apps and to present information 

in a format that is compatible with various 
document types. This means that you 
can search for articles, links and images, 
and then simply pick them up and drag 
them into a document that you are 
already working on. The process is 
simple in the extreme and feels perfectly 
natural when in use, so you should have 
no issues understanding how it works. 
This is the kind of feature that you will 
likely benefit from multiple times a day.

Search and drag Siri results
Drag and drop Siri search results instantly

1 Search as normal
When you search for something 
in Siri, it will present the results in 
a format that is suitable for your 
needs. You can also specify if you 
want to see image or text results.

2 Drag the result
When you see a result presented 
in Siri, pick it up with the mouse or 
trackpad and simply drag it to the 
document that you are currently 
working on. It works very reliably.

3 Image results
You can also ask Siri to search for 
images about a particular subject 
and they will be presented in 
thumbnail form. Pick one up and 
drag it to see it in a larger size.

4 Unusual formatting
Some results, such as web lists of 
searches that are applicable to your 
question, will be presented as an 
image when dragged, but this can 
be useful for research purposes.

Clicking the microphone at the bottom of the Siri panel enables you to 
undertake a new search while the original one is still presented.
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Slight delays
Siri, like any other web service, may 

experience delays from now and then, 
so if you are waiting too long for Siri to 
respond, simply start it up again. This 

often resolves the problem.

Siri is all about vocal commands 
and questions, but on a Mac you 
can easily change what was asked 
and start again. This is useful if you 
coughed while speaking or did not 
pronounce something correctly in 
the original question, and it only 
takes a few seconds to amend 
what you originally asked. There is 
a lot of flexibility included.

Edit your request
You can change your question after it has been asked

1 The wrong 
question
When you have asked 
the wrong question, 
click within the text 
at the top of the Siri 
panel and start typing 
to correct what was 
originally asked. When 
you hit enter Siri will 
search again for a 
new result.

2 The 
right result
A new result will be 
given by Siri as if 
you had never asked 
the original question 
incorrectly. This facility 
is extremely useful 
because Siri is not 
always 100 per cent 
capable of hearing 
everything you say.



Secret ways to 
use Siri in iOS

There are many tricks to 
using Siri successfully 

Check humidity
Siri is capable of
obtaining a wide raft of
information, including the
humidity for a specific
location. Just ask and
the current conditions
will be presented.

 Call me genius
You can ask Siri to 
address you using any 
term you like. Whether 
it be superstar, genius, 
sexy or simply your 
name, it’s a nice 
personalisation touch.

Make decisions
Siri will gladly flip a
coin for you if you are
undecided on something.
Simply say “Flip a
coin” and the randomly
generated result will
appear in no time.

 Check 
connections
At any time you can 
check to see if certain 
wireless features, such as 
Bluetooth, are on or off. 
You can also change their 
statuses using Siri.

Predict
the future
You can ask Siri to use
an Eight Ball to guess if
something will happen.
In this case it looks as
though we will win the
lottery, which is useful!

 Stop the 
interruptions
Ask Siri to “Turn on Do 
Not Disturb” and all of 
the interruptions will stop 
immediately. This is useful 
if you are busy with a 
complex work project.
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Many people use 
Apple Music because 
Siri is able to utilise 
the library of millions 
of tracks and instantly 
play any song 
you want to hear. 
However, Siri can also 
do many other things
with the Apple Music
library and the tracks
and playlists you have
loaded on your phone
or tablet, making it 
an extremely useful 
music controller.

Get the best out of Apple Music
Siri and Apple Music are a very powerful combination

1 Deal with playlists
You can ask Siri to shuffle a playlist by 
naming it within your request. This helps 
add a bit of variety to your morning 
commute and it is something you can do 
before every trip.

2 Play the charts
If you have an Apple Music subscription, you 
can ask Siri to play the number one song or 
the top ten. You can in theory choose many 
different phrases and Siri will respond to 
your commands.

3 Choose a song
You can be even more specific and ask 
Siri to play any song by any artist. If it 
is available in Apple Music it will start 
streaming right away, which gives you 
millions of tracks to play wherever you are.



Remember that the more you use Siri, the better it becomes at recognising 
what you say. Practice makes perfect with Siri.

Stay in touch with friends, 
family and co-workers
Siri is perfect for keeping in touch with important people

The way that Siri is integrated 
with the Contacts app and social 
networks makes it ideal for keeping 

in touch with friends, family and co-workers. 
If you have taken the time to have a complete 
contact list on your iPhone, iPad or Mac, you 
will be able to send messages to people 
without ever touching a screen or a keyboard. 
The same applies to social networks, which 
means that you can add a Twitter or 
Facebook post in seconds and include as 
much detail as you want to. This is one of 
the must useful areas for Siri.
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Control your 
smart home
You can ask Siri to 
control your smart 
home accessories

2 Time to speak
You should now be able to ask Siri to 
interact with each accessory using the 
description or location you have set 
for them. This lets you deal with each 
room as you need to.

1 Use Home
The Apple Home 
app will almost 
certainly be 
needed to control 
your smart 
home devices 
using Siri voice 
commands, so 
make sure that 
everything is 
paired and connected 
properly before you begin.

3 It works!
It may take time to get the names of 
each accessory right, but it won’t take 
long for Siri to be able to help you 
control every aspect of your smart 
home throughout the day.

The trick for using Siri to 
control your home has nothing 
to do with Siri at all. If you 
have your accessories set up 
and connected to your Wi-Fi 
correctly, Siri can be utilised to 
turn lights on and off and do 
many other things around your 
home just by speaking.

1 A complete text
If you ask Siri to send 
a text to someone 
and include the 
entire message, it 
will be displayed on 
screen ready to send 
immediately. It takes 
seconds to send a text.

2 Most recent 
messages
Ask Siri to find your most 
recent messages from 
an individual and you will 
be presented with a list. 
This helps add context 
to new messages you 
may be sending.

3 Find new emails
Locating emails in a 
busy inbox is not easy, 
but you can instead ask 
Siri if there are any new 
messages from anyone 
in your contact list. It will 
save you a huge amount 
of time.

4 Siri and Twitter
Siri can also help you 
quickly post tweets if 
you simply say “Tweet...” 
followed by the phrase 
you want to post, and 
you can also see what 
is trending by asking 
the question.

Specific calling
If you are using Siri to make a call 

you can specify the exact number to 
call the person on. For example, “Call 
Joanne at work” will use the number 
that is in the Work field in Contacts.

“Send messages to 
people without ever 
touching a screen or 

a keyboard”



The best third-party compatible apps
Use Siri to interact with and control your apps

Organise your 
daily life with Siri
Keep your life on track with Siri by your side

The idea of Siri being a personal assistant becomes the most 
obvious when it is used to help you organise your daily 
schedule. You can of course use Siri for communication and 

many other interactions, but the ability to set reminders, create calendar 
events and have alerts appear when you are in exact locations means 
that you will never miss anything important again. Even more importantly, 
it takes almost no time to keep yourself organised with Siri, which will 
give you more free time throughout the day.

54

Siri masterclass

1 Location-
based 
reminders 
You can cleverly 
instruct Siri to set 
a new reminder the 
moment you reach a 
particular location. 
This is ideal for 
location-specific tasks 
such as meetings and 
even for buying gifts.

2 Remind me 
about this
Even more clever is 
the ability for Siri to 
know what you are 
doing and remind 
you about it later. So 
if you are reading an 
email, for example, 
you can set a 
reminder for it to pop 
up at a certain time.

3 Wake me up
You can ask Siri 
to wake you up 
at a specific time 
and the alarm will 
automatically be 
set for you. You can 
also ask for alarms 
to be set on multiple 
days and at specific 
intervals. A simple 
but useful time saver.

4 Move 
appointments
Siri is capable of 
understanding 
what appointments 
and reminders you 
already have set, 
so you can ask for 
the start times to 
be changed over 
and over again just 
by speaking.

5 Work 
with lists
You can also ask 
Siri to create lists 
in Apple Notes and 
then add new 
items at any time. 
This is the perfect 
way to keep track 
of projects and 
tasks that need to 
be done.

6 Set up 
meetings
Siri can set up 
meetings with 
specific people 
using just one phrase. 
All Siri needs is 
the time, date and 
the individual for 
everything to be taken 
care of. The ideal 
personal assistant. 

Map My Run -
GPS Running &
Workout Tracker
Freemium

You have your 
route planned, your 
all-weather gear is 

on and you are ready to run. 
Now all you have to do is 
ask Siri to start tracking and 
you are all set to get fitter.

PayPal Free

Provided you have 
the PayPal app 
set up correctly 

on your iPhone or iPad, you 
can use Siri to quickly send 
money to anyone who is 
listed in your contacts. 
Make sure to double check 
the amount and contact 
first though.

OpenTable -
Restaurant
Reservations Free

You can use Siri in 
the OpenTable app 
to check for 

available reservations, book 
a table immediately and to 
double check when your 
next reservation is booked 
for. It’s flexible and fast.

Zenly - Locate
your friends in
realtime Free

Zenly helps you 
track friends and 
family in a fun way, 

but you can also send quick 
messages if you are meeting 
up. Here Siri will speed up 
that process so that you do 
not miss each other.

Canva - Graphic 
Design & Photo
Editing Freemium

Canva is a superb 
app for editing 
photos and 

creating unusual designs, 
but you can also search your 
image collections using Siri. 
It’s a simple integration, but 
it works very well.



Another useful feature is the ability to instantly download an app using Siri. 
Just say “Download…” and the app name to start installing it.

Use Siri when 
ou’re out and about

Siri can be the best travelling 
assistant in the world

 Working 
together
Siri is designed to work 
with a variety of apps, 
particularly those built 
by Apple, so you can 
leverage a huge number 
of features by using your 
voice alone.

 Complete 
results
Many location-based 
results will be returned 
with reviews from 
other users, distance 
measurements and 
everything else you need 
to go there straight away.

 Ask for anything
Don’t worry about using 
specific phrases when 
speaking to Siri. Simply 
ask a question or tell Siri 
that you need something 
and the right answer 
should come back in 
an instant.

 Never get lost
Siri works with Apple 
Maps to let you ask any 
location-based question. 
For example, you can 
ask “Where am I” and 
an address and map will 
be displayed. 

 Transport 
modes
When asking for 
directions, you can 
specify if you are walking, 
driving or using public 
transport. The answer 
will be detailed and 
Maps will then take you 
to your destination.

 Become a child
Siri is capable of 
understanding human 
questions and so “Are 
we there yet?” works 
just as well as “How 
much longer is left of 
my current journey?”.
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Ask for anyone
You can ask Siri to find local services 
including electricians and plumbers, 

or you can even ask for specific 
medication to find a chemist. If you 

need something quickly, just use Siri.

Seven - 7 Minute
Workout Training
Challenge Freemium

Setting up for a 
workout takes time, 
so it makes sense 

that you can simply ask Siri 
to begin tracking you in the 
Seven app. An effective time 
saver perfect for your daily 
exercise routine.

WhatsApp
Messenger Free

Siri can now work 
directly with 
WhatsApp to 

ensure that you get the 
message over when your 
hands are busy. It potentially 
makes the app even easier 
to use than the traditional 
tapping screen method.

Skype for
iPhone Freemium

Skype is an 
excellent 
communications 

tool that works well in a 
hands-free environment, 
and with Siri alongside to 
help you can now make 
calls without ever touching 
your phone.

Vogue Runway
Free

The Siri integration 
in Vogue Runway is 
designed to help 

you use the main features of 
the app and to discover the 
latest fashion trends at any 
time. It’s not necessary, but 
it highlights just how useful 
Siri really is.

Uber Free

The Uber app is 
designed to let 
you catch a ride 

in the quickest possible 
time and with Siri also on 
hand to help, you will be 
able to make a booking 
in seconds. Everything 
works exactly as it 
should here.
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1 Opening 
confirmation
When opening up Focus for the 
first time, you’ll be prompted to 
confirm the details of your privacy 
settings, after which the app will 
load onto the homepage. 

2 Load a site
Use the central toolbar to open 
a site in Focus. Users can choose 
to enter a web address, or you can 
instead perform a private search 
using Firefox’s native search 
engine if needed.

3 Open in Safari
On certain sites you may prefer 
using Safari. If this is you, press 
the bottom-right share icon to 
load the page directly into Safari. 
This is useful for confirming 
payment of items, for example. 

4 Find Settings
Go ahead and start typing out 
a new web address. However, 
from here you’ll want to select 
the cog icon that sits just above 
the keyboard, which opens the 
Settings section. 

Download available

Time needed

20

Use Firefox Focus 
as your new browser 

Safari has long been considered the browser of choice for 
many iOS users, but there are some real alternatives that are 
free to download from the App Store. One of these is Firefox 
Focus, a relatively new browser on the scene that looks to help 
provide a secure place for you to browse the web in peace. 
Mozilla Firefox has been a highly successful desktop browser, 
and Focus carries on the tradition well. It’s kitted out with an 
array of privacy features, many of which can help you remain 
completely anonymous online and prevent any sort of site 
tracking. Even better, your browsing history can be wiped in 
seconds – and we mean seconds – so you can have the peace 
of mind that you’re staying safe when browsing the web. Here 
we’ll demonstrate some of the beneficial features of Firefox 
Focus, including a few of its privacy and security settings and 
tools, to help ensure a safe browsing experience.

Browse the web with Firefox FocusStep-by-step
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More iOS privacy browsers

1 Opera Coast
Opera Coast can boast to be one 
of the more user-friendly browsers 
out there, but it’s also got some nifty 
privacy features. Managing history, 
user data and tracking data can all 
be done through a single menu.

2 Ghostery
There are no signups, no user data 
and no cookies – instead this is a 
browser claiming complete anonymity.
Its best feature is its Ad Tracker, 
which will send you a warning when it 
believes a site is tracking you.

3 Chrome
Chrome has a built-in
mode, which is ideal f
privately on your iOS
prevents automatic tr
web usage, and can e
potentially block out m

5 Manage integration
At the top of this menu, you’ll have 
the choice to integrate Safari into 
the app. For users, this will mean 
importing payment info, certain 
bookmarks and other details 
across to Focus.

6 Toggle privacy
Underneath that you’ll find a 
host of privacy options. Make 
sure to enable all of these 
options, as they prevent an array 
of trackers from being able to 
monitor your browser usage.

7 Erase your history
Back out of the Settings section 
and proceed to search for a site. 
Once you’ve viewed the site, press 
the erase option to delete your 
history of it. This will prompt a 
notification at the bottom.

8 Content blocking
You’ll also want to enable Focus 
as a content blocker in Safari, 
again to help with privacy. Open 
the Content Blockers tab within 
Safari’s settings and enable Focus 
as an option.

To help improve the performance of Focus, you may want to disable 
web fonts. You can do this through the Settings section of the Focus app.
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Photos

Download available

Time needed

10

Crop, filter & adjust 
Live Photos in iOS 10 

Live Photos is a feature Apple brought to the iPhone 6s and 
6s Plus in 2015 with the introduction of 3D Touch and a much-
improved camera sensor. Live Photos captures a second and 
a half of audio and video before and after you take the photo. 
We’ll show you how to activate this underused feature, view 
your library of Live Photos and then take them to the next level 
with a few straightforward editing tweaks. With a few taps you 
can do everything from boosting the colours to cropping, and 
make them perfect for sharing. Editing capabilities are only 
available in iOS 10, so make sure you’re running the latest 
software, and to take a Live Photo you need an iPhone with 
3D Touch capabilities. So that’s everything that comes after the 
6s and 6s Plus, and you can use either the front or rear-facing 
camera. Pick up your iPhone and let’s get snapping.

“With a few taps you 
can do everything 
from boosting the 
colours to cropping, 
and make them 
perfect for sharing”

Edit your Live PhotosStep-by-step

1 Activate 
Live Photos may or may not 
be activated by default on your 
iPhone. In the main Camera 
viewfinder, tap the three circle 
icon above the flash icon to 
enable Live Photos. 

2 Select a Live Photo
Live Photos live in your Camera 
Roll like any other photo. You 
won’t notice any difference until 
you tap on one and it gives you 
a little video preview of the action 
before the shot was taken. 

3 Find editing menu 
Making edits to a Live Photo 
is essentially the same as any 
another image you’ve taken. Tap 
on one and then hit the editing 
icon at the bottom to load up 
Photos’ familiar editing panel.
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It’s probably best not to have Live Photos activated all the time, especially if 
you’ve only got a 16GB iPhone. It’ll take up quite a bit of space.

Got yourself a great Live Photo and 
want to turn it into a GIF for social 
media? Google’s free Motion Stills 
app gives you the tools to do so. 

Transform 
into GIFs

1 Find the app
Grab Motion Stills from the App 
Store and allow access to your 
Photos library. The app searches 
for Live Photos in your Camera 
Roll. Tap the one you wish to use.

2 Create a GIF
Once it’s downloaded, tap the 
photo again to turn it into a GIF. A 
menu appears enabling you to loop 
endlessly, mute audio and add text. 
Tap the share icon when ready. 

7 Adjust light
You can make finer adjustments 
to the light and colour of your 
Live Photo too, just by tapping 
the clock icon at the bottom and 
navigating the menus. There’s 
even a Black & White option. 

4 The magic wand 
The first port of call should 
almost always be the magic 
wand tool. This one-click solution 
automatically brightens up the 
colour in your image, boosting 
saturation to make it pop more.

8 Add a filter
No modern iPhone image is the 
same without a filter placed on top 
of it, so tap the Filter icon at the 
bottom and select from the nine 
available options. When you’re 
finished editing, simply tap Done. 

5 Crop the image
Tap the Crop tool to line your 
shot up better. The tool will 
automatically perform an edit 
for you, but feel free to drag the 
image around (using the grids as 
guidelines) until you’re happy.

9 Revert to original
Because editing a Live Photo is 
identical to any normal photo, all 
the editing you perform is non-
destructive. This means you can 
tap Revert in the bottom right at 
any time to go back to the original.

6 Change format
You can even change the format 
of your image in the Crop tool. Tap 
the three boxes icon to load up 
the adjustment options. Posting 
to Instagram? Tap on the Square 
option to change the format.
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Wipe your iPhone 
clean ready to sell 

One of the beauties of Apple products is that they hold their 
value remarkably well. Even a three-year-old iPhone is worth 
a fair amount towards your summer holiday fund. It obviously 
needs to be in good condition, whether you’re selling it to a 
company you’ve seen advertising on the TV, an online auction 
site like eBay or a local community site like Gumtree. Over 
time you will have stored a lot of personal data on that device, 
and wiping it clean of your iPhone history isn’t as simple as 
erasing all the content. You need to sign out of iCloud properly, 
for example, otherwise the buyer is going to have a world of 
problems setting it up as their iPhone.

1 Back up and unpair
Whenever you play around with crucial system 
information, make sure you perform a backup 
of your iPhone, either in iCloud or iTunes. If you 
have an Apple Watch, now is the time to unpair. 

2 Sign out of iCloud 
Go to Settings and find iCloud. On its main 
screen, scroll down and tap Sign Out. Tap Sign 
Out again, then Delete from My iPhone. Now 
enter your iCloud password to confirm. 

3 Remove all content 
Make sure you sign out from your iTunes and 
App Store accounts too. Now go to General> 
Reset>Erase All Contents and Settings and 
enter your Apple ID to wipe your iPhone. 

Erase all personal contentStep-by-step
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Highlight your work
Tap the Me icon and choose any tweet that 
you have posted recently. Now tap the small 
chevron top right and choose ‘Pin to your 
profile’ to have it displayed whenever anyone 
looks at what you have been posting. It will 
appear at the top of your tweets at all times.

Customise your timeline
Twitter likes to present your tweets in 

an order that it feels is best for you. If, 
however, you want them in chronological 

order, go to Me, tap the cog icon, 
Settings and Timeline to disable the ‘best 

Tweets’ feature. Try each version and 
choose your preferred one.

Night mode
The new night mode 
feature is useful in all 

sorts of circumstances. 
To set it up, tap the cog 

icon while in the Me 
screen and then select 

‘Turn on night mode’. 
The screen will turn dark 

– as a result your feed 
will be much more 

viewable in low light, 
and also less likely to 

disturb others.

A busy experience
Many of Twitter’s best features are less obvious

 Tap to connect
Tap this icon to connect to new people 
instantly. Twitter has put a lot of work 
into ensuring that you are only offered 
new people who you will be interested 
in following.

 Customise
Under the Me tab, and 
more specifically the 
cog icon within the 
resulting screen, you 
will be able to tailor 
the Twitter experience 
to your exact needs 
and preferences.

 Deal 
with media
This tiny chevron is 
used to offer the ability 
to mute individuals 
and conversations, 
block people and even 
create a new Moment 
based on the content.

Twitter

10 amazing 
Twitter 
secrets

Twitter has undergone a variety of improvements over time, 
but in order to keep the interface usable and a pleasure to 
work within, many of its features are somewhat hidden and 
are not always obviously placed, so you may benefit from 
knowing some of the secrets. Twitter, like all of the best 
social networks, can be anything you want it to be and this 
means that you can decide exactly who appears in your 
timeline and how their tweets are displayed. You can then 
work with multiple accounts to give yourself a personal and 
work presence on Twitter. Twitter on mobile is more useful 
than ever, but it pays to understand some of the secrets to 
ensure you get the full benefits from it.

Get to know more of the ins and 
outs of the Twitter app with these 
ten hidden Twitter secrets
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Connect with others
While in the Home view, tap the top-left 
icon and you will see a new Connect
screen appear. Twitter will display a large 
selection of users who may interest you 
based on who you currently follow. The trick 
will be ensuring that you do not follow too 
many people.

Manage the web
When a link is embedded in a tweet, 
you can tap it to see it displayed in a new 
window within Twitter. To see it in Safari, 
tap the sharing icon and then Open in 
Safari, or tap More to share the page 
with others using different services. It is 
extremely flexible.

Swap and send
If you are in the middle 
of creating a tweet and 
decide that you want to 
send it using a different 
account, tap your avatar 
top left, and all of the 
available accounts will 
be presented for you 
to use. You can now 
select a different one 
and compose the exact 
same tweet.

Mute a 
conversation
One of the best Twitter 
features is the ability 
to track a conversation 
between people you 
follow, but what happens 
if it dominates your 
timeline? Go to a tweet 
within it, tap the chevron 
and then ‘Mute this 
conversation’. It will not 
affect any of your 
Twitter settings.

Think 
about privacy
In Settings>Privacy and safety, 
you can take a minute to 
ensure that you are as safe as 
possible while using Twitter. For 
example, you can stop others 
from finding you by your phone 
number or email address, 
which could be useful in some 
very specific circumstances.

Use multiple 
accounts
To use more than one Twitter 
account in the mobile app, go 
to Me and tap the icon with 
two people in it at the top. Tap 
More options and then either 
‘Create new account’ or ‘Add 
an existing account’ to use 
multiple accounts in the future. 
You can swap between them.

Mute a person
There will be people that 
you know, be it friends or 
colleagues, who become 
completely different people 
on Twitter. To avoid upsetting 
them by unfollowing, you can 
tap any tweet that they have 
posted, tap the chevron and 
then select Mute @name to 
hide their tweets.

Don’t forget that you can access stickers while tweeting a photo by 
tapping the smiley face icon. The range available is remarkably varied.
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PayPal
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Use Siri to send 
money via PayPal

You will likely be aware of just how easy it is to send money via 
a phone now, but it is only recently that Apple has allowed Siri 
to be taken advantage of when doing so. This means that to 
send money in a flash, all you need to do is say that you want 
to send a certain amount of money, and then who to and by 
what method – which in this case will be PayPal. 

It is incredibly easy to do, almost disconcertingly so when 
you consider that you are sending real money, but there are 
checks in place to ensure that you are the owner of the PayPal 
account and that the money will go to the right person. We will 
show you how to send money and also how to set up PayPal 
and Siri to work together. This process is easier than you would 
expect it to be and will be sure to save you a lot of fiddling 
around. Let’s send some money. 

Send money in an instantStep-by-step

“There are checks in 
place to ensure that 
you are the owner of 
the account and that 
the money will go 
to the right person”

1 Set it up 
The quickest way to set up the 
link is to open Siri and say “Send 
money via PayPal”. You will need 
to accept the displayed warning 
by tapping Yes and you are 
good to go. 

2 The right phrase 
You can now say how much you 
want to send, including the right 
currency and the correct recipient, 
and of course you need to mention 
PayPal for the process to work as 
it should. 

3 A handy list 
A list of potential contacts 
may appear if you are using a 
common name or if that person 
has multiple email addresses 
and phone numbers included in 
their contact card.
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You will need iOS 10 installed to send PayPal money using Siri, but the 
recipient does not even need to be using iOS.

The PayPal app offers many 
money-related facilities and Siri can 
be used to access some of them. 
Here are two simple examples.

Further 
features

1 Choose a currency
When requesting money, simply 
say the currency you want to use 
and PayPal will do the rest for you. 
This is ideal for dealing with friends 
and work colleagues abroad.

2 Request money
You can also ask Siri to request 
money from a contact who is using 
PayPal by saying the name and the 
amount. Again, Siri will go away 
and do the hard work for you.

7 Double check 
You may want to open the PayPal 
app the first few times in order to 
make sure that the money has 
been sent correctly, but there is 
no reason why any part should 
be incorrect. 

4 The security 
Once you have chosen the exact 
contact details you need, you will 
be prompted to use Touch ID or 
to enter your PayPal password in 
order to prove who you are. It’s 
very secure. 

8 Cancel the payment 
If you tap the actual payment in 
the PayPal app, you will have 
the opportunity to cancel it if its 
current status is pending, so there 
are useful safeguards built in if the 
need arises.

5 A confirmation card 
A card will appear on the Siri 
screen showing exactly where 
the payment will be going and 
also the amount for you to double 
check. Tap at the bottom to send 
the money. 

9 It’s the same 
The recipient of the funds will 
be completely unaware that Siri 
has been used to help send the 
money. All Siri does is make the 
initial process much quicker 
than before. 

6 It is done 
A confirmation card will now 
appear to confirm that the money 
has been sent without you ever 
needing to open the PayPal app. 
You can now continue using Siri 
as normal. 
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Add complications 
to Apple Watch faces

Complications are those tiny slices of information you see on 
many Apple Watch faces. They can tell you the weather, give 
you a health status update, show you when messages or 
emails are available to read or even let you go direct to your 
music. But you don’t have to stick with the complications that 
are shown by default. As well as being able to use lots of first-
party complications created by Apple, you can also add many 
highly useful complications that have been produced by third-
party developers.

Many apps downloaded from the App Store come with 
the bonus of a complication. These can take you straight to 
your Hue lights setup, enable you to make instant language 
translations or show you the latest football scores, for instance. 
Indeed, complications can add so much to your overall use of 
an Apple Watch, so you really owe it to yourself to explore all of 
the options available. Here we look at how they can be added 
to your Watch face.

Add complications on the WatchStep-by-step

1 Find complications
Some third-party apps installed on your Watch 
support complications. They automatically 
appear in the Watch app on your iPhone, so 
look under My Watch>Complications.

2 Choose a face
Grab hold of your Watch and press down on 
the Watch face. You can swipe left and right to 
select the face you wish to add complications 
too. When you’re done, tap Customise.

3 Locate the menu
In the customisation mode, swipe left to the 
final screen. You’ll see the complications you 
can alter, highlighted by boxes. Tap the one to 
change and it will be ringed green.
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Edit your third-
party complications
Remove complications by other
apps to streamline your options

Edit mode
This top right-hand corner usually shows the
word Edit. Clicking it opens up the options on
this page and when you’re finished editing,
you just tap Done.

Reorder and customise
Tap and hold on one of these buttons and you
are able to move complications up and down
the screen, reordering them to suit your wants
and desires.

Delete complications
Complications can be removed from the list by
tapping the red button next to a listing. They
don’t disappear from the screen; they just
move to the section Do Not Include.

Add a complication
Complications auto-appear when you
download a supporting app, but you can
add any you’ve previously removed by
tapping the green button.

Knowledge base

Can’t find a
complication?
Some complications will only
work with certain Watch faces
and in certain spots, so if you
can’t see your choice this is
likely to be the reason why. Note
too that you can’t customise
the Solar or Astronomy faces,
but if you wish to maximise the
number of complications you
can have on the screen at once,
go for the Modular option.

going to the Face Gallery on the iPhone Watch app.

4 Rotate Digital Crown 
By rotating the Digital Crown, you’ll see the 
various available complications. They will 
include those by Apple and those introduced 
by third-party apps such as Lifesum.

5 Select the complication
When you have chosen a complication, you 
can move on to another slot and do the same. 
How any complications you have depends on 
the number of compatible installed apps.

6 Finish off
Once you are happy with the added 
complications, you can press the Digital Crown 
to go back to the main face-selection menu. 
Tap the face you’ve created and you’re done.
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Scribble text 
replies in Messages

Handwrite messages on your WatchStep-by-step

1 Find Scribble option
To reply to a message, tap the Scribble option 
at the end of a message thread. Or Scribble a 
new message by force holding the screen and 
tapping New Message>Create Message.

2 Use your finger
Simply draw letters of the alphabet and 
numbers on the screen. As you do this, the 
characters appear at the top of the screen, 
allowing you to check them as you go along.

3 Choose right words
By turning the Digital Crown, you are able to 
speed up the writing process even further by 
calling up a series of recommended words. Tap 
the one that best fits your text.

Back in the day, people would use personal digital 
assistants such as a Palm or Apple’s Newton – devices 
that used handwriting recognition software and made 
it easier for users to input their words. Today, tech is far 
more advanced and yet this functionality has made a 
comeback on the Apple Watch. It feels like technology 
is going full circle, except it makes perfect sense. When 
you have a screen as tiny as the Watch, there’s no way 
Apple can fit a full keyboard onto it. Handwriting your 
messages is therefore intuitive, easy and fast.

The option was introduced with watchOS 3 and it is 
simply a matter of activating Scribble and jotting down 
your pearls of wisdom or instructions. Here we take a 
look at how to do just that, together with little tricks 
you can use to make scribbling even more useful. 
With suggested words and simple ways to add some 
punctuation, it’s bound to become your preferred 
method of writing.
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Understand the 
Scribble interface
Apple has created a very simple 
and intuitive interface for fast replies

 Tap a word
You can also tap any of the words in your 
sentence to see recommended words, and 
you can move back and forth through a 
message using your finger.

 Delete incorrect text
If you make a mistake, don’t worry. You 
can simply tap the delete button found here 
to go back one space at a time in order to 
correct it. 

 Cancel a message
As you’d expect, if you decide you don’t want 
to reply at that time or if you make a mess of 
the message, you can just hit Cancel in the top 
left to go back to the message threads.

 Draw special characters
You can draw exclamation marks, hashtags, 
@ symbols, dashes and more. The interface 
will fully recognise what you’re trying to write 
and add them to the text entry bar.

You can use the Scribble feature when you’re replying to a Message 

 Knowledge base

How accurate is 
Scribble?
You’d be surprised. Scribble is 
very adept at recognising what 
you are typing. You may need to 
be rather quick with some of the 
characters – if you don’t form a 
hashtag quickly enough, there’s 
a chance it will think you’re 
writing the word ‘it’, for instance 
– but you’ll soon get the hang of 
it without needing to adapt your 
handwriting to any great degree.

4 Write even faster
You don’t need to wait until one character 
disappears off the screen before you scribble 
another. You can even fit more than one letter 
or number on the screen at once.

5 Add the punctuation
Although you can draw punctuation such as 
exclamation marks, you can also press the 
word Space to put a gap between your words. 
Double pressing Space will add a full stop.

6 Send a message
Once you have completed your message, you 
just need to press the Send button. Your words 
will appear in the familiar Messages button as a 
normal entry within the thread.
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Read interactive books on your TV
Children love a good story, especially when they are being read
in a very entertaining way. Apple’s iBooks StoryTime app taps
into this desire, with dozens of books aimed at children under
six. Each story has read-along narration and, in the majority of
cases, highlighted words to follow too.

It means children can see and hear stories unfold before
their eyes, helped along by some lovely illustrations. And even
though you have to purchase the vast majority of the books,
the prices are generally low, with try-before-you-buy options
available. Just make sure you have a fourth-generation Apple
TV with the latest version of tvOS before you get started.

With iBooks StoryTime, you can bring classic and modern children’s favourites to life

iBooks StoryTime

Download available

Time needed

10

Find a good book

Knowledge base

Manage your books
You are not restricted to buying 
your read-aloud books via 
iBooks StoryTime. You can also 
find and purchase them using 
your Apple ID from within the 
iBooks Store or iTunes Store 
using your iOS device, Mac 
or PC. You have to use these 
devices to manage your books 
too, as there are no management 
options available within the 
Apple TV app.

 Preview option 
The best way to figure whether or not 
a book will be suitable for your child is 
to take a sneak peek beforehand. The 
Preview option downloads a few pages 
from the book, complete with voiceover.

 And there’s more
Click on the word More and you 
will be able to read a full synopsis 
of the book and a short biography 
of the author, helping you with your 
buying decision.

 Number of pages
Each book will give you an 
indication of the number of pages 
it has and it will also show you 
the size of the download, which is 
great when space is at a premium.

 Read the title
Many of the books will be read by a celebrity, 
which can either be the authors themselves, 
as seen here with David Walliams, or by the 
likes of comedian Lenny Henry.
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1 Download the app
To use the interactive books with read-aloud 
narration, you must have the Apple TV app 
iBooks StoryTime installed. Grab it for free from 
the App Store and click to open it.

2 Install a book
You’ll be asked if you want to download the 
book Dora’s Big Buddy Race for free. It’s a 
good way to familiarise yourself with how the 
books work, so try it by clicking Get.

3 View your library
Each book that you download will be clearly 
stored in the app’s library within a section 
handily called My Books. To start reading your 
first book, simply click on it.

4 Start reading along
The books take good advantage of your 
TV screen and they have lovely, colourful 
illustrations. The narrator will begin reading the 
story out loud, so ensure your volume is up.

5 Pause a book
Most books highlight the words as they are 
being spoken. If you want to pause the book 
at any point, just tap the Play/Pause button on 
your Apple TV remote, and again to resume.

6 Turn over pages
Swipe on the touchpad of the remote to turn 
the pages back and forth. The books will 
automatically flip when they reach the end of a 
spread though, making reading seamless.

7 Stop reading aloud
If you would prefer the book not to read aloud, 
you can turn this function off. Simply pause 
the book and swipe down. Then select the Off 
button to silence the app.

8 Get more books
To expand your library, go back to My Books 
and press the Menu button on your remote. 
Swipe over to the section marked Featured 
Books and you can see other available stories.

9 Select a story
Click on a book you like the look of and you 
can select to buy it (a few are free). The book 
will then be added to the section My Books, so 
click the one you want to read.

Read and navigate children’s booksStep-by-step
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Since Apple TV is very much a family device, it tends to be
used by various people in your household. For that reason, 
Apple enables you to add multiple IDs, which means more than 
one iTunes account can be used to buy apps, games, films 
and TV shows. It also means you can switch between IDs for a 
more personal experience, although it is not possible to log in 
to more than one account at the same time.

You can, however, use Family Sharing, hooking up multiple 
accounts so that your family’s purchases are available for all. 
You can see your shared content by selecting Movies, TV 
Shows or App Store and choosing Purchased>Family Sharing.

Add multiple Apple IDs to Apple TV
Share your Apple TV with others by letting them use their own account

Add extra accounts to Apple TVStep-by-step

Download available

TIME NEEDED

10

DIFFICULTY

1 Find the account
Open the Settings app and click on Accounts. As 
you did when setting up your multiple accounts, 
you will need to select iTunes and App Store from 
the list of available options.

2 Select it
You will see the extra account you have created, 
so select it to switch over. You can have many 
accounts here by going back over the steps in the 
main tutorial for other IDs.

After you have set up other IDs, you need to 
know how you can switch to them. It’s rather 
straightforward, using only a few button presses.

Use another 
account

1 Open Settings app
Extra accounts need to be added within 
Settings, so open up the Settings app on your 
Apple TV before highlighting and selecting the 
second option down, marked Accounts. 

2 Select iTunes
On the next page, you need to select iTunes 
and App Store. You will see that it is already set 
up with an account. The one we create is going 
to be in addition to that one.

3 Add new ID
Now choose Add New Apple ID. On the next 
page, you will see all of the previously used 
Apple IDs with an option to clear them all. We 
want to Add New, so select this option.

4 Sign in
Now you can sign in using a different Apple 
ID. Use the on-screen keyboard to input your 
username and then input the password for that 
account. Click Sign In to add the ID.

Settings
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e i s r
Our Apple devices and the software on them are some of the finest 
products on the planet, but even they have their moments. We’re here 
to give you expert advice and get you back up and running in no time

I have a Safari extension that places an annoying ‘share’ button
over every image online. How do I get rid of it? Ellen Poole

Touch Bar
A new input on MacBook
Pros that features a thin
touchscreen Retina display
in place of a keyboard’s
function keys.

Pentalobe
A proprietary screw type
used by Apple, often to
secure the bottom casing
of its laptops.

Extensions
Third-party add-ons
that work within Safari
to provide additional
functionality when
browsing the web.

Keynote
Apple’s presentation
creation software, similar
to Microsoft’s PowerPoint,
available on macOS/iOS.

Screenshot
A photo of whatever your
device’s screen is currently
showing, captured using
the device itself.

Grade
Colour correction given to
scenes in a film to make
them look consistent.

Some extensions have the option
to turn off their share buttons

1 It’s your preference
To remove annoying extensions
completely, fire up Safari and open
its preferences by hitting Cmd+, or
heading to Safari>Preferences in
the menu.

2 Find the extension
Click on the Extensions tab
at the top of the Preferences
window, then select the offending
extension from the list of them on
the left.

3 Uninstall it
Check the extension’s preferences 
for an option to turn off share 
buttons, or click Uninstall to 
remove it completely. Restart 
Safari to finish.

The place to 
come for key 
terms made easy 
to understand 

Glossary

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
www.gadgetdaily.xyz

Email
icreate@imagine-publishing.co.uk
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1 Show Track Lock
Right-click a track’s header, then
click Track Header Components>
Show Track Lock to reveal the
padlock icon next to your tracks.

2 Lock the tracks
Click on the padlock icon next to
any track you’d like to stop from
being accidentally recorded over.
Now you’ll never lose a great take!

3 Unlock it again
If you need to make any edits to a 
track later on, you’ll need to ensure 
it’s unlocked. Simply click on the
padlock icon once more to do this.

GarageBand, can I do anything to prevent this? Freya Priest

How can I set up my Keynote presentation to play automatically 
for visitors to my school’s information evening? Bill Collins

 Time it right
If you’re setting up a self-playing show, 
it’s extremely important that you get your 
timings right for slides and transitions so 
everything can be read. Test this out and 
tweak as necessary!

 Loop it round
Presuming you want your slideshow to 
run all evening, you’ll want to check the 
Loop slideshow button so it restarts itself 
automatically once it gets to the end of your 
deck of slides.

 Self-playing show
Click on the Document button in the top-
right corner of Keynote and ensure that your 
Presentation Type is set to Self-Playing so 
visitors don’t have to click through your 
slides manually.

 Restart if idle
If you’ve set your slideshow up as self-
playing this shouldn’t matter, but checking 
the Restart show if idle option is a good 
insurance policy to have just in case things 
go wrong.

The one-stop
column for
Genius advice
Why do I have to 
type my password 
just to stop my Mac’s 
screensaver from 
running? It slows me 
down so much at work.
This should be easily 
fixed by unchecking a 
setting. Head to System 
Preferences>Security 
& Privacy>General and 
uncheck the Require 
password setting, or at 
least increase the time it 
takes before the setting 
kicks in when your 
screensaver starts.

How do I get my Finder 
windows to always open 
with the same size and 
position? It’s annoying 
when they change!
Okay, open up a single 
Finder window (ensure all 
others are closed), resize 
it as you like, close that 
window, Alt/Opt+click 
on Finder’s icon, then 
click Relaunch. Now you 
should have a window 
size that’s consistent 
every time it opens.

I’m struggling to 
search for anything 
successfully in Mail. 
Messages I know should 
be there just aren’t 
showing up for me.
Often this issue is pretty 
easily solved by rebuilding 
your Mailbox. To do this, 
head to Mailbox>Rebuild 
in Mail and let the process 
run through. This should 
fix the issue.

Apple 
Expert

coconutBattery is a surprisingly 
powerful and useful free utility

I’ve updated to macOS Sierra 10.12.2 and 
now it won’t tell me how long until my 

battery dies! What can I do? Kyle Mason
We feel your pain, Kyle! This feels a little silly of Apple. 
Fortunately, there’s a free, third-party app that can 
provide this information. Download coconutBattery 
(coconut-flavour.com/coconutbattery), fire it up and 
you’ll find all the information you’re missing and more. 
Head into its Preferences (Cmd+,) and you can choose 
to have it as a menu bar item and display the time 
remaining on your battery’s charge. It’ll even give you 
info like battery health, too.

If you’re leaving a Keynote presentation running on your Mac, ensure you 
set it up on a new account so visitors can’t access your private information.
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Genius Bar

The one-stop
column for
Genius advice
Where’s the new iOS 
10.2 SOS feature that 
was supposed to be 
released? I thought it 
was such a great idea!
We agree, tapping your 
power button five times 
to start an SOS call is a 
great idea. Unfortunately, 
it’s only available in India 
right now, but we’re sure 
this feature will roll out 
elsewhere in the world in 
the coming months.

I love the handwriting 
feature in Messages, but 
how do you delete old 
handwritten messages 
from the bottom?
Open up a new Message 
and rotate your phone 
into landscape mode to 
bring up the handwriting 
window. From here, tap 
and hold on any of the 
saved messages in the 
bottom row, then tap on 
the X that appears next to 
them to delete them.

Any advice for avoiding 
a mucky screen when 
I’m reading recipes from 
Safari on my iPad while 
cooking in the kitchen?
How about having Siri 
speak those recipes out 
loud? To do this, you’ll 
need to enable the Speak 
Screen setting under 
Settings>General>
Accessibility>Speech. 
Now, navigate to any 
webpage and ask Siri to 
“speak screen” to hear 
the recipe while you cook.

Apple 
Expert

Help! I deleted a note
on my iPhone with all

of my lecture notes in by
accident. Can I do
anything to get it back?
Tracey Phillips
Don’t worry, Tracey! All is
not lost, providing you didn’t
delete that note more than
30 days ago. Open up
Notes and tap on the < in
the top-left corner to go
to the overview of Notes
folders on your device.
There you should see a
Recently Deleted folder.
Tap on that to find and
restore those lecture notes.
Be quick to do this, though.
Notes that are more than
30 days old are deleted
from there forever and
can’t be retrieved.

I’m a bit of an
Instagram fiend. Is

there a way to set my
iPhone’s camera to always
be in Square mode for
photos? Tania Lomas
If you’ve updated to iOS
10.2, Tania, you’re in luck!
Open up the Settings app and
navigate to Photos & Camera.
Tap on Preserve Settings and
then ensure that the Camera
Mode option is enabled by
tapping on its switch. Now, if
you open up the Camera and
set the mode as Square, it’ll
stay that way until you change
it again, no matter how many
times you close and reopen
the app. It works for other
modes as well, so setting your
camera to Video will also stick,
for example.

Retrieving your old notes is 
possible for a limited time

My iPad is brand new but is draining really quick. Any idea what’s 
wrong here? Could it be a rogue app at play? Ali Cairns

 Check ‘em out
Take a look at how long each 
app has been on screen or in the 
background for and compare 
that to the amount of battery 
percentage they’ve used.

 Check your settings
Open up the Settings app and 
tap on the battery option down 
the left-hand side to bring up the 
details on how apps consume 
battery power.

 Tap the time
Tap the clock item on the right 
above the list of apps and their 
power usage. This will show you 
how long each app has been 
used for.

 A rogue one
If an app hasn’t been on for 
long (but might be active in the 
background) and has used lots 
of battery, it might be draining 
your iPad.
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You can add your iOS device back onto the beta program again at any time 
by heading to beta.apple.com

I signed up for iOS betas but I want normal updates now. 
How do I get them back in Software Update? India Warren

Can I get any control over the fonts I use in Pages on my 
iPad? Or is it too lightweight an app for that? Justin Voakes

What’s the easiest way to round up 
and delete all the accidental

screenshots I’ve taken while I’ve been 
unlocking my phone? Eric Palmer
Good thinking, Eric. All those accidental
screenshots will most certainly start to add 
up and take up room on your device. To find 
them all fast, simply open up Photos, tap 
on the Albums tab and scroll down until you 
find the Screenshots album. From there, tap 
Select in the top right, Select All in the top left, 
then tap on the trash can to delete them all for 
good. You might need to confirm this deletion, 
especially if there’s a lot of screenshots to go. 
They should now be gone!

How can I make the clips in my 
iMovie project look more 

consistent? They’re all lit differently and 
shot on different days. Rob Hawes
Applying a project filter in iMovie is a 
great way to give the resulting film a more 
consistent look and feel. Better still, you 
can still apply filters to individual clips below 
this. To add a project filter, tap on the cog 
icon near the preview window, tap on the 
project filter you’d like to use then tap out of 
the settings window. Applying a project filter 
is non-destructive, so you can always jump 
in and change it, if you’d like. For clips that 
still look wildly different, you can apply 
individual filters to try and bring them a bit 
closer together.

The screenshots folder makes it easy 
to filter them out

Using a project filter gives your 
film a more consistent ‘grade’

 Size it up
To change font size, tap the As 

Scrolling down in this menu 

 Tap the name
Changing fonts in Pages for iOS 

up the keyboard and tap on the 

 Change the weight
To change a font’s weight (light, 
heavy and so on), tap on the i 
symbol to the right of the font’s 

 Justify yourself
Finally, if you wish to change the 
alignment of the text in your document, 
tap on the icon that’s sitting to the right 

1 Find the setting
Open up your Settings app 
and head to General>Profile. 
Here you’ll find the iOS Beta 
profile that tells Apple to send 
you all the beta updates. 

2 Select the profile
Depending on your iPhone’s 
setup (especially if you’re beta
testing other apps), you may 
see a few profiles. Select the 
iOS Beta Software one.

3 Delete and restart
Open up the iOS Beta profile, 
hit Delete, enter your password 
to confirm, then restart your 
device. Now you should 
receive regular updates again.
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1 Pry the cover
Use your spudger to carefully pry off the bottom
cover. Be careful to avoid damaging the screw
posts at the bottom and upper sides of the case.

2 Antenna up
Remove the six T6 Torx screws securing the antenna
plate in place (note their different lengths and
locations) and slowly lift it to one side.

3 Unscrew and disconnect
Remove the T6 Torx screw securing the antenna
connector to the AirPort card then use your spudger
to lift away the connector altogether.

4 Remove the screws
Remove the top two Torx screws (marked in red)
and loosen up the bottom captive screw (marked in
orange) on your Mac mini’s fan.

5 A careful lift
Lift the fan unit up slightly to free the captive screw
and slightly down towards the bottom of the base so
you can access its connector.

6 Disconnect it
For the final step, use your spudger to disconnect 
the fan’s connector. Give it a clean and follow these 
instructions in reverse to replace.

My 2014 Mac mini’s fan sounds pretty tired! 
Is it easy to clean or replace myself? Kim Sky

If your Mac mini is sitting in a particularly dusty environment, there’s a 
chance your fan might be a little clogged up. If you’ve got a spudger 
and a T6 Torx screwdriver handy, you can have a go at opening it 
up and cleaning it out yourself. It’s a relatively easy process, but can 
get a little fiddly, so take it slow and be extra careful. If you’re not 
feeling confident in carrying out the job yourself, take it down to your 
nearest Genius Bar for guidance. If you’re up for having a look yourself 
though, read on to find out how it’s done. Our friends at iFixit.com 
provided the photos, and they’ll sell you the tools if you need them.

Genius Bar

The one-stop
column for
Genius advice
I can’t adjust the volume 
on my Mac, the controls 
are disabled and It 
shows a circle with a 
line through it.
If you’ve recently had 
headphones or speakers 
plugged in, try plugging 
them in and removing 
them again. Sometimes 
this issue is caused by 
your Mac not recognising 
that a device has been 
unplugged from the audio 
jack socket.

My iPhone shuts off 
as soon as battery hits 
around 20 per cent. 
Sometimes it switches 
back on and other times 
it needs charging.
It sounds like your battery 
needs to be replaced. 
Take your iPhone to an 
Apple Store for a Genius 
Bar appointment. They 
can run a test to see if 
this is the case and help 
replace it if that’s what 
needs to be done.

My MacBook Pro’s 
screen is really dusty 
and has fingerprints all 
over it. What should I be 
using to clean it?
Apple recommends 
sticking to using nothing 
more than a soft, lint-
free cloth to clean your 
devices. There are also 
Mac-specific cleaning 
sprays out there. If you go 
down that route, use them 
sparingly and never spray 
directly onto your device.

Apple 
Expert
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Tools needed
Missing any of these?
You can order any
parts or tools you
might need from
www.ifixit.com/store.

screwdriver

Rich Coombes

Although USB-C has now replaced Apple’s 
legendary MagSafe connector for charging, 
you can luckily replace the ports (should a 
power cable get stuck in one). You’ll have to 
remove the Logic Board first, though.

iFixit struggled to free this part from the 
MacBook Pro in their teardown, so we’d 
advise against trying to repair this yourself. 
It’s best left to those clever folk at Apple’s 
Genius Bar to look at.

Unfortunately, iFixit’s teardown revealed that
the batteries in the new MacBook Pros are
very much stuck to the casing with strong
adhesive, so replacing them won’t be easy, if
at all possible.

It probably comes as no surprise, but the
RAM on the new MacBook Pro is soldered
to the Logic Board, so be sure to spec up
your machine appropriately before you go
ahead and buy it.

The biggest surprise here is that the trackpad
is easily removed and replaced. Once you’ve
lifted off the bottom casing, a few T5 Torx
screws hold it in place. Remove these and
you’re away.

Apple’s portables are becoming less and less repairable, especially now that most models have RAM
and SSD chips soldered directly onto their Logic Boards. If you’re looking for a device that’s easy to
upgrade, you’re out of luck. In that sense, your decision to get a top-of-the-range model is the right
one. Buy the best now and you’re less likely to end up shelling out for another model at a later date
when you’re in need of more RAM or storage. That said, when it comes to repairing parts or replacing
them outright, the new MacBook Pros do have a little surprise. Our friends at iFixit tore one down and
did the hard work here. In return, we’ll point out where your new MacBook Pro can be easily repaired.

Picking up a new fan for a 2014 Mac mini is relatively cheap. Our friends at 
iFixit.com sell new replacements for approx £45/$55.

If you would like more help with upgrading your Mac, visit the 
gadget surgeons at iFixit.com, who kindly contributed these photos.
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Best iPhone 7 docks
Group test

iPhone Lightning Dock
£49/$49

www.apple.com

If you want a dock to perfectly match the colour 
of your iPhone, Apple’s official Lightning Dock 
is the obvious choice. Available in five metallic 
finishes, it’s a simple way to charge and sync 
any Lightning-compatible iPhone. It certainly 
looks the part, but the problems only surface 
when you connect your iPhone. The dock is 

so light that even the slightest touch, let alone 
trying to tap the Home button, makes you fear 

it will topple over. Even the non-slip base is 
easily shifted. This is one of the rare times when 
we’ll advise you to go for a third-party option.

Wiplabs iDockAll
£29.99/$36.99

www.mobilefun.co.uk

The iDockAll enables you to easily use your 
iPhone one-handed, a feature not to turn your 

nose up at given the competition. There’s some 
real weight to the dock, and means it’s sturdy 
enough to support the weight of an iPad too. 
The extra weight also stops the dock moving 

around. The dock itself has a nice curved 
design, and a handy backrest adds even more 
support. Our brushed silver review unit looked 
like a premium product. You need your own 
Lightning cable, but it attaches securely in 

place and the cable is nicely tidied as a result.  
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Fuse Chicken 
Bobine Dock

£29.99/$36.99
www.mobilefun.co.uk

We’ve seen some interesting products in 
our time, but this flexible, levitating dock from 

Fuse Chicken might just be the strangest. 
There’s certainly nothing wrong with trying to 
stand out from the crowd – this is after all the 
only dock in the test that doesn’t conform to 

traditional design protocols – but it would help 
if the dock actually worked. Connecting the 
USB port to your Mac is a nuisance, but the 
real pain lies in getting the right twists and 
kinks in the wire to support your iPhone. It 

does charge your phone, but this isn’t 
something we’d recommend. 

Belkin Charge 
+ Sync Dock

£39.99/$48.99
www.mobilefun.co.uk

Belkin’s Charge + Sync Dock takes design 
cues from Apple and is very pleasing on the 
eye as a result. The elegant aluminium finish 

complements any iPhone, and looks nice next 
to an iMac and Magic Trackpad. Thankfully 
there’s a bit more weight to this dock, while 
the cradle backing gives reassuring support 

when you’re using your phone. You’ll find your 
index finger happily rests behind the cradle for 
extra support. The base feels much more non-

slippy compared to Apple’s, and there’s 
a Lightning cable in situ.  



A quick double-tap can launch Siri or
play/pause the currently playing music

The lightness and lack of wires ensure the 
AirPods are likely to stay in place

82
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Your only concern will be to ensure that 
you do not lose them. They are tiny!
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AirPods
£159/$159

A highly innovative and emotionally pleasing product that ticks every box in style. 
Verdict

Key features

Learn more Available from

The wireless headphone category has 
grown ever so slowly over the past few 
years, with the general perception being 
one of paying more for lesser sound 

quality just to remove the wire running from the music 
device to your ears. Apple sought to change that with 
the AirPods, but the company didn’t settle for simply 
improving the quality, instead throwing in a raft of 
innovative features that make the AirPods feel 
completely natural in use. From the moment you flip 
the lid of the charging case and see them paired to 
your iPhone automatically, to then realising that they 
have also paired with every device signed in to your 
Apple ID, the experience is magical from the start. 

It does not stop there, however, because the small 
software touches continue to amaze with simple 
interactions making you want every product to work 
this way. Flip the lid of the case again and the battery 
levels for the case and each AirPod are displayed 
on your home screen. Put one AirPod in your ear 
and it starts playing paused music or podcasts, put 
the second AirPod in and you have excellent-quality 
stereo sound instantly. When you remove an AirPod 
the track is paused, only to play again when placed 
back in your ear. The use of accelerometers here is 
well considered and crucially the system works every 
time, to the point that it soon feels clunky when using 
headphones that do not do this. They also recognise 
when you are speaking and can filter out background 
noise; this makes the AirPods perfect for voice calling 
and the end result is arguably as good as you get 
with standard Apple EarPods, with just a hint of 
crackling now and again when you speak. Hopefully 
this minor downside can be adjusted in software, but 
be assured that the AirPods still offer the ability to 
make and receive calls in a manner that you will find 
more than acceptable. 

So, the AirPods shine in terms of practicality, but 
crucial to this is the ability to keep them charged. 
Apple has cleverly solved this potential problem by 
offering five hours of power per AirPod alongside a 

huge 24 hours in the charging case. As the case is 
so small, it means that you will always have more 
than enough power with you, and even if you run into 
trouble you can gain three hours of battery life from a 
quick 15-minute charge. 

It really is a case of Apple ticking all of the boxes 
in terms of battery life, sound quality and software 
finesse, but there remains an area that is tricky for 
any headphones that have one set form – how they 
fit your ears. For some people the EarPods are not a 
great fit and tend to slip out when moved a lot, but 
things are different with the AirPods. In our tests, it 
appears that the lightness and the fact that no wires 
are dragging on the speakers eases much of the 
tension, and we have yet to find anyone who is really 
struggling to keep them in place. Indeed, for most 
people the main sensation is to completely forget 
that they are in after a minute or so because they are 
so comfortable, but the omission of any hardware 
buttons does feel strange at first. A double-tap on 
an AirPod can launch Siri or play/pause the current 
track, but it does take some getting used to talking 
to Siri to skip a track. You can of course still manage 
tracks using the screen on your device.

It is often too easy to get excited about a new 
Apple product, but in the case of the AirPods the 
praise is fully deserved. We have genuinely struggled 
to find any downsides with this product and have 
been surprised time after time by how cleverly and 
efficiently they work. Even the price, which appears 
high at first glance, is well within range in this area 
of the market. With almost all good-quality wireless 
headphones coming in at a higher price and with 
the majority also not including the W1 chip, the 
AirPods do represent good value. The look when in 
your ears may cause surprise from others initially, but 
just like the first mobile phones the AirPods really do 
feel like the start of something big. We are sure that 
the competition will be falling over themselves to 
produce competing products but, at this time, Apple 
is clearly winning. 
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The Immerse headphones come with a
USB charge cable, 3.5mm double jack
in-flight adapter and 3.5mm aux-in cable

The side buttons are useful for stopping
the music, but can also rewind to the
last song or fast-forward to the next

The ear cups are comfortable, light and 
cancel out any exterior sound without 
them feeling too tight around your head 

£60/$72

Verdict

kitsound.co.uk kitsound.co.uk

With so many headphones on the market these days, 
it’s easy to assume that the more money you have 
to pay for a pair, the better quality you’re going to 
get. Unlike when earphones first became available 
with early iPods, headphones are now seen as an 
investment; if you buy a good pair now, they’ll be 
built to last far longer than your current phone.

 The KitSound Immerse noise-cancelling 
headphones have the feel of a high-end set coupled 
with an affordable price. With their simple matte 
black finish and red mesh on the inside of each 
cup, they’re not the slickest or most attractive set 
on the market, but first impressions are still good. 
The comfort that the Immerse Headphones offer is 
superb; the foam isn’t too firm, it fits over the ear 
nicely and it doesn’t feel too snug on the head. 
Though the headphones are noise-cancelling, they 
don’t feel strapped to your head too tightly, like other 
models can often feel. 

 The sound quality is pleasantly surprising. The 
bass is strong and the sound is extremely clear, with 
every instrument feeling like it has its own space 
within the mix. It isn’t the crispest quality that money 
can buy, but for the price it’s extremely good. The 
headphones can be connected via an AUX cord, 
Bluetooth or jack, and are charged via USB cable.

 There are buttons on the side of the ear cup to 
either stop, start or skip songs; these buttons are 
usually located on the wire of most headphone 
brands, and they perhaps make more sense here, 
as you can’t actually see what button you’re pressing 
when wearing the Immerse headphones.

 The headphones fold up nicely with no fuss 
though. While similar-looking headphones may be 
ideal for studio use, the Immerse headphones are 
perfect for on-the-go listening. They cancel noise 
well, feel fantastic, and for the price you’re paying 
the sound quality is amazing. 
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YOU CAN’T 
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The lens system comes with five gel 
inserts that will enable you to securely 
attach the bracket to your iPhone

The lens bracket features a cold-shoe 
mount for attaching lighting and audio 
recording accessories

The ExoLens features the patented 
ZEISS T* anti-reflective coating to ensure 
your results are bright and impressive

The ExoLens will certainly help users improve their smartphone photography, 

ZEISS ExoLens Pro 
wide-angle kit

£199.95/$199.95

Verdict

Key features Learn more
exolens.com

Available from
apple.com/uk

This wide-angle ExoLens from ZEISS is the perfect 
tool for harnessing the power of the already 
impressive iPhone 7 camera – it will also work on 
the iPhone 6 and 6s as well as the iPhone 6 Plus 
and 6s Plus. Some smartphone lenses can feel a 
little gimmicky and don’t always appear to be of the 
highest quality, however, this lens system has a very 
high-end finish and fits securely to the iPhone. 

The tightly fitting gel insert for the iPhone 7 comes 
already installed in the lens bracket – the other inserts 
are included in the set and are labelled accordingly. 
The instructions are incredibly simple, which means 
that you can set everything up very quickly. It can be 
a little difficult to attach the bracket onto the iPhone 
on the first use as you have to be quite firm, but once 
the attachment is in place there were no concerns 
that the lens was at risk of falling off. Ensuring that the 
lens is centred over the iPhone’s camera can be a bit 

tricky though, and if it is even the tiniest bit off-
centre you will have some issues with your imagery.

The wide-angle lens provides an angle of view 
equivalent to an 18mm lens, which gives you a 
wider angle of view than the iPhone 7 will usually 
provide and will enable you to capture more of your 
surroundings. In general the results with the lens were 
really impressive, with not much noticeable distortion 
and good contrast and colours. However, in our 
testing there was vignetting in the right-hand corners 
while using the camera in landscape mode, which 
was disappointing for a lens priced so high.

It is by no means perfect, but with its high-quality 
build and impressive results in general it is clear that 
this lens is ideal for those who are serious about 
taking their smartphone photography to the next 
level. However, at just short of £200, it is perhaps not 
suited for those with an existing camera kit.
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Slightly subpar headphones from Libratone, though the noise cancelling was good for 
the price. The Q Adapt On-Ears need a lot of improvement in future iterations.

Libratone Q Adapt 
On-Ear headphones

£219/$249

Verdict

Key features Learn more Available from

Danish designers Libratone produced an incredible 
wireless speaker in the Zipp, so it’d be normal to 
feel some trepidation with its headphone products. 
Thankfully these Q Adapt On-Ears are efficient and 
easy to use, as we’ve come to expect from Libratone.

Adorned in either monochrome black or white, the 
Q Adapt On-Ears retain some of the familiarity with 
the Zipp’s Italian wool cover in the textured feel of the 
headband material. They’re easy to use and set up; 
just turn them on along with the Bluetooth on your 
iOS device and you can start listening wirelessly to 
anything you stream from the device. Volume can 
be controlled with touch controls on the left earpad, 
which were unfortunately unresponsive at times.

There are different modes for noise cancelling too, 
with 20 hours’ worth of battery use: an applaudable 
amount of battery power. The quality of noise 
cancelling was generally okay, but we found that total 
noise block was a bit lacking compared to one of the 

best active noise-cancelling headphones that 
we tested in 2016, the Sony MDR-1000X at £360. 
But with consideration of the £100-cheaper price, 
the Q Adapt On-Ears are still worth using. 

The bass is generally impressive, with layer 
precision in Starboy by The Weekend, yet average, 
unremarkable mids in Unfinished Sympathy by 
Massive Attack. Joy Division’s Atmosphere also had 
noticeably deficient strings which dulled the quality 
of the intro.

The main caveat for us though, was comfortability. 
The earpads were quite small, sitting on the ear 
awkwardly but not in a snug fit. The metal attachment
between the earpads and the headband meant that 
it was also quite tight in the wrong places, with lots of 
fiddling to get to the right position. 

It’s slightly disappointing for headphones with a 
pricepoint at over £200, though it’s worth a look in for 
anyone wanting cheaper noise cancellers.
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iStorage datAshur 
Personal2 8GB

£39/$TBA
istorage-uk.com

We’ve shown you how to lock down files 
on a USB flash drive over on page 42, but 

iStorage offers an ingenious solution thanks 
to integrating a PIN number board onto the 
drive itself. Once you’ve entered a new PIN 

(it needs to be between 7 and 15 digits), only 
that password can unlock the drive and allow 
access to its contents. A seriously clever idea 
for anyone who is worried about the security 

of data kept on a USB drive. Setup is relatively 
simple (you do need to read the quick start 

guide), and our only concern is the cost.

Reviews

Accessories
Onkyo X9

£249.99/$TBA
www.onkyo-speakers.com

Onkyo is aiming specifically at the top of the 
audiophile market with its new High Res Audio-

accredited X9 speaker. It’s being marketed 
as the first portable speaker to achieve that 

rating, and this is because you can connect the 
speaker to your Mac via a wired connection 

and play high-res 24-bit, 96kHz files. Although 
the X9 acts as a more consumer-friendly 

speaker too, the preferred wired connection 
leaves us a bit confused as to the speaker’s 
purpose. That said, the difference between 

standard streaming quality and FLAC is really 
noticeable. The X9 is very powerful, but never 

at the detriment of the detail.

Element Case Aura 
Luxe Collection

£24.95/$39.95
www.elementcase.com

For those of you who crave real protection for 
your iPhone, that invariably means covering 
it in a bulky, heavy-duty case. The Aura case 
from Element is a nice compromise, offering 
some sleek design and military-grade drop-

test protection. The case comes in three parts, 
which click reassuringly into place; just make 

sure it all lines up properly otherwise the volume 
buttons won’t work. The elastomeric lining 

cushions your iPhone in the event of a fall, while 
the soft-touch satin and high-gloss ends keep 
your iPhone looking the part. All in all, probably 
the best rugged case we’ve ever come across.
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Audio-Technica 
AT-LP60BT

£189/$179
www.audio-technica.com

The resurgence in vinyl shows no signs of 
abating, so it might be time to jump onboard 

the bandwagon. And if you want traditional vinyl 
sound quality, but quite like the modern wireless 

world, Audio-Technica might just have the 
device for you. That’s because this vinyl player 
can stream music to your living room’s wireless 
speaker system thanks to its built-in Bluetooth. 
Sound quality is surprisingly good too; there’s 

a warm and fun reproduction that makes a 
mockery of its price point. You do lose some 
detail, and the plastic design is by no means 
premium, but this is a fantastic vinyl player. 

Cygnett 
ChargeUp Digital

£29.95/$49.99
www.cygnett.com

On our list of wishes for 2017, better battery 
life would rank high. But that isn’t going to 

happen. In the meantime, a power bank is your 
best bet if you’re a power user. This offering 
from Cygnett is one of the best we’ve seen – 

it’s super-thin, packs a lot of juice and is cross-
device compatible. The dual USB ports enable 
you to charge two devices at once, and some 

clever tech means you aren’t splitting the power 
between the two. The 6,000mAh capacity 
gives you nearly three full charges of your 

iPhone, and the digital display lets you know 
exactly what’s left in the tank. 
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while keeping artefacts such as colour noise to a minimum.

RAW Power
£7.99/$9.99

Verdict

Requirements Learn more
gentlemencoders.com

Available from

To get your photographs looking their best you 
need to shoot using your camera’s RAW format 
setting. Unlike the compressed JPEG format, a 
RAW file contains much more information about 
your subject’s colours and tones. This enables 
you to recover more tonal detail than you could 
when working with a JPEG. The RAW Power app 
harnesses the same RAW macOS processing 
engine used by Apple’s Photos app, but it gives 
you access to more sophisticated and powerful 
image-editing tools – and all for an affordable 
one-off fee.

As with the RAW editing tools in the Photos 
app, you can selectively target specific tones in 
RAW Power and reveal missing shadow or highlight 
detail. However, to help you identify which areas 
are over or underexposed, RAW Power goes further 
by providing you with clipping warnings. These 
colourful patches enable you to target and reveal 

missing details more effectively than you can 
when using Photos’ more basic image-editing 
tools. You can also spot clipped areas by holding 
down the Command key as you drag tone-
tweaking sliders.

When shooting in low light your camera will 
use a high ISO value to capture the scene, but 
this adds nasty noise to the shot. Photos enables 
you to reduce luminance noise, but you’ll need 
RAW Power to banish additional rainbow-like 
specks of colour noise. You can also adjust a 
shot’s colour temperature using a slider that works 
in the degrees Kelvin scale and eliminate green or 
magenta tints to create true colours.

When working with RAW files, the Photos app 
will do a good job of revealing missing tonal detail 
and correcting colours, but RAW Power will give 
you the edge if you need to produce the best-
looking shots possible. 

Photos integration
You can easily access RAW Power

as an extension from within the

Cool curves

Clipping warnings

3 Key Features

“Target missing 
details more 

effectively than 
when using 

Photos’ more 
basic tools”
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Spark shines thanks to its beautifully considered interface and the way it presents 
complex features in the most natural of ways. A brilliant email solution.

Spark - Love 
your email again

Free

Verdict

Requirements Learn more Available from

Email apps are hardly uncommon, 
but solutions that offer an experience 
comparable to the standard iOS Mail client 
are. Even rarer are apps that actually make 

the iOS Mail client look quite simple while maintaining 
minimalist usability, but Spark succeeds very well in 
these areas. The presentation of your incoming mail 
is as clear as you could wish for, and the inclusion of 
bubbles at the top ensures that you will never miss 
communications that you absolutely must read in 
good time. Quick replies let you handle emails in a 
similar way to text messages and with the ability to 
create your own, you will benefit from extra speed 
and an added personal touch each time you send 
a new email. The smart categorisation is designed 
to split busy inboxes into manageable chunks and 
natural language searching ensures that you can find 
what you need no matter how busy you are. 

Ultimately, however, it is the way all of the above 
has been polished and gently squeezed into an 
interface that works perfectly on an iPhone, iPad 
and even an Apple Watch that is most impressive. It 
takes a huge amount of hard work to make an email 
client that feels at home on a small screen, and in 
the case of Spark you are looking at one of the very 
best email clients ever created on any platform. The 
app manages to offer the familiarity of emailing while 
simultaneously making your daily communications 
feel fresh, and in a way that creates a sense of using 
a completely new form of communication. Whether 
the end result has come by luck, focused judgement 
or a huge amount of work, Spark is an email solution 
that you should try for a long period to see if it works 
for you. It is quite possible that you will have found 
a client that could dominate your daily emailing for 
years to come. We think we have.

3 Key Features

The important mail

Snooze your 
communications

An integrated workflow
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Secrets is a simple tool for storing passwords and other information securely. 

Secrets
£14.99/$19.99 (premium version)

Verdict

Requirements Learn more
Mac App Store

Passwords are a pain, partly because good ones 
are impossible to remember and also because 
these days we need so many of them. It is hard to 
do anything on the internet or on your Mac without 
a password. There are several great apps available to 
help store your passwords, like Dashlane, 1Password 
and LastPass, but there is always room for another 
and Secrets is an alternative worth considering.

Secrets runs on the Mac, iPhone and iPad (where 
it is called Secrets Touch), and its main purpose is 
for storing login details for websites. You can create 
login entries by adding a friendly name, username, 
password, URL and notes. Unlike some password 
managers that automatically create entries when you 
log in to sites for the first time, Secrets doesn’t. You 
must open the app and create the item. It seems to 
pick up some details and it suggests the name for 
example, but the app isn’t as integrated as some 
other password managers.

When creating an account at a site, Secrets 
can create passwords for you. They can be from 
4 to 50 characters and you can choose whether to 
use uppercase, lowercase, numbers and symbols. 
Making very secure passwords is easy – once a 
login has been created, you can go to a site with a 
single mouse click, fill in the login details with another, 
and you’re in.

Secrets stores more than login details; credit cards 
can be added, software licenses can be saved and 
everything else can be stored in notes. Information 
in Secrets is encrypted with OpenPGP and AES and 
is synced across Mac, iPhone and iPad apps using 
iCloud. Ten items are stored for free, and unlimited 
items for £14.99/$19.99.

The app is cheaper than some password managers 
and the import feature makes it easy to switch from 
rivals. Dashlane, 1Password and LastPass are better, 
but some people might prefer Secrets’ simplicity.

Auto-lock Secrets
Choose when to automatically lock
the Secrets app depending on your

activities, set timers and more

When adding a login, use the
password generator for a secure

Use iOS apps
Put Secrets Touch on the iPhone 

or iPad and sign in. It automatically 
fetches all of your passwords

3 Key Features

“Information is 
encrypted and 

is synced across 
Mac, iPhone 

and iPad apps 
using iCloud”
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In the age of information, where a whole 
myriad of intimidating apps bombard 
users with up-to-date analyses, clickbait 
articles and notifications of breaking 

bulletins, it’s refreshing to see Quartz’s minimal and 
engaging take on news consumption.

Quartz provides bite-sized news stories in the 
format of a conversation. The concept is not too 
dissimilar to the original iteration of the Circa News 
app, summarising core facts of the story in digestible 
snippets. However, as the news ‘conversations’ are 
written by Quartz’s own team, there’s a distinct style 
and tone of voice that complements the content.

Two to three messages are typically displayed 
per story alongside imagery. They appear one after 
another in one scrollable screen, with a button to 
lead you to the next story of the day or a button for 
you to read a bit more on the current story. What’s 
enjoyable about the app are the extraneous features. 

The use of photography, GIFs and emojis add flair 
to each news article. There are also notifications 
you can set to alert you of ‘really, really big news’, a 
regular alert once or twice a day, but it’s the inclusion 
of the entertaining ‘market haikus’, or tiny poems of 
17 syllables, detailing the big economy story of the 
day that really adds another level of amusement. 
Even if you’ve run out of stories to read, there are 
quick-fire quiz questions to keep you interested in 
current affairs.

If you want to read outside of the app, Quartz 
provides the original source of its written stories 
that you can tap on for more information on a third-
party site. It should be noted that you can’t choose 
any sources for Quartz to collect its stories as the 
content is written in advance, unlike other apps such 
as News, nor can you choose your own topics. But 
for anyone after fast, to-the-point summaries of the 
biggest stories of the day, Quartz is a perfect fit.

Short and sweet
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As coin collecting goes Nintendo has successfully delivered a 

£7.99/$9.99

Verdict

We used

Available from

Super Mario Run was met with much anticipation 
upon announcement at Apple’s September keynote, 
with Nintendo legend Shigeru Miyamoto producing 
the project. Launched to iOS three months later, fans 
worldwide have downloaded in droves to get to grips 
with how it plays. The good news is, Super Mario Run 
tweaks a classic run-and-jump formula pretty cleverly 
to deliver an addictive touchscreen experience. 

The portly plumber now sprints through levels 
automatically, harmlessly vaulting over enemy Koopa 
troopers, Goombas and the like with zero fuss. He 
jumps by varying distances and heights based on 
your taps, most effectively with your thumb tip on any 
part of the screen. Master this to bound across gaps, 
stomp foes, bump blocks, flip switches and scale 
heights in traditional style to collect coins. Coins are 
everything in Super Mario Run and not purely to post 
higher level scores than your friends, but also when it 
comes to replayability. The main Tour mode features 

six Worlds of three stages, so 24 levels in total once 
you pay the in-app price to unlock the full game. This 
challenge follows the typical quest to free Princess 
Peach from Bowser’s clutches, but average players 
will breeze through it in one sitting. It’s then about 
gathering five pink, purple and eventually black coins 
scattered throughout, with each type progressively 
more tricky to obtain. Progress here yields Toad Rally 
tickets for testing your skills against ghost players, a 
sort of race mode for accumulating fans that join and 
level up your Kingdom. Here you can buy buildings 
with all those collected coins, unlock new playable 
characters and even access exclusive bonus courses. 

Everything is done with trademark Nintendo polish, 
looking and sounding true to the series while adding 
ingenious nuance to deceptively simple gameplay. 
Whether it justifies the entrance fee is cause for much 
debate, but as an authentic slice of Nintendo’s most 
enduring franchise it simply cannot be matched.
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